
UPCISS 

 

  

Free Online Computer Classes on 
YouTube Channel UPCISS 

www.youtube.com/upciss 

Video Tutorial 
LibreOffice Full Playlist Available 

on YouTube Channel UPCISS 

Copyright © 2019 UPCISS 

LibreOffice 



UPCISS 
 

2 
 

 

 

  

  

LibreOffice is a powerful and free office suite, used by millions of people around the world. LibreOffice is a 
successor to OpenOffice.org (commonly known as OpenOffice), which in turn was based on StarOffice. Its 
clean interface and feature-rich tools help you unleash your creativity and enhance your productivity. 
LibreOffice includes several applications that make it the most versatile Free and Open Source office suite on 
the market: Writer (word processing), Calc (spreadsheets), Impress  

(presentations), Draw (vector graphics and flowcharts), Base (databases), and Math (formula editing).  

LibreOffice is compatible with a wide range of document formats such as Microsoft® Word (.doc, .docx), Excel 
(.xls, .xlsx), PowerPoint (.ppt, .pptx) and Publisher. But LibreOffice goes much further with its native support 
for a modern and open standard, the Open Document Format (ODF). With LibreOffice, you have maximum 
control over your data and content – and you can export your work in many different formats including PDF.  

  

What is LibreOffice?  
LibreOffice is a free and open-source office suite (Program) and a project of The Document Foundation. It was 
forked from OpenOffice.org in 2010, which was an open-sourced version of the earlier StarOffice. The 
LibreOffice suite comprises programs for word processing, the creation and editing of spreadsheets, 
slideshows, diagrams and drawings, working with databases, and composing mathematical formulae. It is 
available in 115 languages.  

LibreOffice is available for a variety of computing platforms, including Microsoft Windows, macOS, and Linux 
(including a LibreOffice Viewer for Android), as well as in the form of an online office suite LibreOffice Online. 
It is the default office suite of most popular Linux distributions. It is the most actively developed free and open-
source office suite, with approximately 50 times the development activity of Apache OpenOffice, the other 
major descendant of OpenOffice.org.  

The project was announced and a beta released on 28 September 2010 Between January 2011 (the first stable 
release) and October 2011, LibreOffice was downloaded approximately 7.5 million times. The project claims 
120 million unique downloading addresses from May 2011 to May 2015, excluding Linux distributions, with 
55 million of those being from May 2014 to May 2015.  

  

Applications of LibreOffice  
LibreOffice is look like Microsoft Office and its application also work as Word, Excel, PowerPoint and access 
programs. LibreOffice Include 6 applications which is as per given below:  

1. Writer  

LibreOffice Writer is a word processor with similar functionality and file support to Microsoft Word or 
WordPerfect. It has extensive WYSIWYG word processing capabilities, but can also be used as a basic 
text editor.  

  

2. Calc  

LibreOffice Calc is a spreadsheet program, similar to Microsoft Excel or Lotus 1-2-3. It has a number of 
unique features, including a system which automatically defines series of graphs, based on information 
available to the user.  
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3. Impress  

LibreOffice Impress is a presentation program resembling Microsoft PowerPoint. Presentations can be 
exported as SWF files, allowing them to be viewed on any computer with Adobe Flash Player installed.  

4. Draw  

LibreOffice Draw is a vector graphics editor and diagramming tool similar to Microsoft Visio and 
comparable in features to early versions of CorelDRAW. It provides connectors between shapes, which 
are available in a range of line styles and facilitate building drawings such as flowcharts. It also includes 
features similar to desktop publishing software such as Scribus and Microsoft Publisher. It is also able 
to act as a PDF-file editor.   

5. Math  

LibreOffice Math is an application designed for creating and editing mathematical formulae. The 
application uses a variant of XML for creating formulas, as defined in the OpenDocument specification. 
These formulas can be incorporated into other documents in the LibreOffice suite, such as those 
created by Writer or Calc, by embedding the formulas into the document.  

6. Base  

 LibreOffice Base is a database management program, similar to Microsoft Access. LibreOffice Base 
allows for the creation and management of databases as well as the preparation of forms and reports 
that provide end users easy access to data. Like Access, it can be used to create small embedded 
databases that are stored with the document files (using Java-based HSQLDB and C++ based Firebird 
as its storage engine), and for more demanding tasks it can also be used as a front-end for various 
database systems, including Access databases (JET), ODBC/JDBC data sources, and MySQL, MariaDB, 
PostgreSQL or Microsoft Access.   

  

Operating Systems  
The Document Foundation developers target LibreOffice for Microsoft Windows (IA-32 and x86-64), Linux (IA-
32, x86-64, ARM) and macOS (x86-64). Community ports for FreeBSD, NetBSD, OpenBSD and Mac OS X 10.5 
PowerPC receive support from contributors to those projects, respectively. LibreOffice is also installable on 
OpenIndiana via SFE.  

In 2011, developers announced plans to port LibreOffice both to Android and to iOS. A beta version of a 
document viewer for Android 4.0 or newer was released in January 2015. In May 2015, LibreOffice Viewer for 
Android was released with basic editing capabilities. The LibreOffice Impress Remote application for various 
mobile operating systems allows for remote control of LibreOffice Impress presentations.  

  

  
LibreOffice Online  
LibreOffice Online is the online office suite edition of LibreOffice. It allows for the use of LibreOffice through a 
web browser by using the canvas element of HTML5. Development was announced at the first LibreOffice 
Conference in October 2011, and is ongoing. The Document Foundation, IceWarp, and Collabora announced 
a collaboration to work on its implementation. A version of the software was shown in a September 2015 
conference and the UK Crown Commercial Service announced an interest in using the software. On 15 
December 2015, Collabora, in partnership with ownCloud, released a technical preview of Libreoffice online 
branded as Collabora Online Development Edition (CODE). In July 2016, Nextcloud and Collabora partnered to 
bring CODE to Nextcloud users. By October 2016, Collabora had released nine updates to CODE. The first 
source code release of LibreOffice Online was done with LibreOffice version 5.3 in February 2017.  
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Miscellaneous features  

 LibreOffice can use the GStreamer multimedia framework in Linux to render multimedia content such 
as videos in Impress and other programs.  

 Visually, LibreOffice used the large "Tango style" icons that are used for the application shortcuts, 
quick launch icons, icons for associated files and for the icons found on the toolbar of the LibreOffice 
programs in the past.   

 With version 6.2, LibreOffice includes a Ribbon-style GUI, called Notebookbar, including three 
different views. This feature has previously been included as an experimental feature in LibreOffice 6.  

 LibreOffice has a feature similar to WordArt called Fontwork.  

 LibreOffice supports multiple file format.  

 LibreOffice has a feature to access files remotely.  

  

The Document Foundation and LibreOffice  
On 28 September 2010, The Document Foundation was announced as the host of LibreOffice, a new derivative 
of OpenOffice.org. The Document Foundation's initial announcement stated their concerns that Oracle would 
either discontinue OpenOffice.org, or place restrictions on it as an open source project, as it had on Sun's 
OpenSolaris.  

LibreOffice 3.3 beta used the ooo-build build infrastructure and the OpenOffice.org 3.3 beta code from Oracle, 
then adding selected patches from Go-oo. Go-oo was discontinued in favour of LibreOffice. Since the office 
suite that was branded "OpenOffice.org" in most Linux distributions was in fact Gooo, most moved 
immediately to LibreOffice.  

Oracle was invited to become a member of The Document Foundation. However, Oracle demanded that all 
members of the OpenOffice.org Community Council involved with The Document Foundation step down from 
the OOo Community Council, claiming a conflict of interest.  

  

  

  

Users and Deployments  

 2011: The Document Foundation estimated in September 2011, that there were 10 million users 
worldwide who had obtained LibreOffice via downloads or CD-ROMs. Over 90% of those were on 
Windows, with another 5% on OS X. LibreOffice is the default office suite for most Linux distributions, 
and is installed when the operating system is installed or updated. Based on International Data 
Corporation reckonings for new or updated Linux installations in 2011, The Document Foundation 
estimated a subtotal of 15 million Linux users. This gave a total estimated user base of 25 million users 
in 2011. In 2011, the Document Foundation set a target of 200 million users worldwide before the end 
of 2020.  

 2013: In September 2013, after two years, the estimated number of LibreOffice users was 75 million. 
A million new unique IP addresses check for downloads each week.  

 2015: In 2015, LibreOffice was used by 100 million users and 18 governments.  

 2016: In August 2016, the number of LibreOffice users was estimated at 120 million.  

 2018: The Document Foundation estimated in 2018 that there are 200 million active LibreOffice users 
worldwide. About 25% of them are students and 10% Linux users (who automatically receive 
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LibreOffice through their distribution). In comparison, Microsoft Office was used in 2018 by 1.2 billion 
users.  

  

Derivatives  
 Collabora supplies branded and customized LibreOffice versions LibreOffice Vanilla for Mac, 

GovOffice, Collabora Office, Collabora Online Development Edition and Collabora Online.  

 EuroOffice is a derivative of LibreOffice with free and non-free extensions developed by Hungarian-
based MultiRacio Ltd.  

 "LibreOffice powered by CIB" is a branded and customized version of LibreOffice developed by 
Germany-based CIB software GmbH.  

 "NDC ODF Application Tools" is a derivative of LibreOffice provided by the Taiwan National 
Development Council (NDC) and used by public agencies in Taiwan.  

 NeoOffice 2017 and later versions are based on LibreOffice. Previous versions included stability fixes 
from LibreOffice.  

 OxOffice is a derivative of LibreOffice (originally a derivative of OpenOffice.org) with enhanced 
support for the Chinese language.  

  

Interface- LibreOffice   
LibreOffice provides a common interface to all applications such as Writer (Word Processor), Calc 
(Spreadsheet), Impress (Presentation), Draw (Drawing), Math (Formulas), Base (Database). You can create a 
new Document, Spreadsheet, Presentation, database or drawing etc.   

You can open any type of files by using Open Files or Recent Files commands.  You can also access the Remote 
files which are store online (Google Drive, One Drive, Open Data Space etc.) If you want to access files 
remotely, you need an online account and password. You can open and create a templates for all its programs.  
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LibreOffice Writer lets you design and produce text documents that can include graphics, tables, or charts. You 
can then save the documents in a variety of formats, including the standardized OpenDocument format (ODF), 
Microsoft Word .doc format, or HTML. And you can easily export your document to the Portable Document 
Format (PDF). LibreOffice Writer have following features:  

  

Writing  

LibreOffice Writer lets you create both basic documents, such as memos, faxes, letters , resumes and merge 
documents, as well as long and complex or multi-part documents, complete with bibliographies, reference 
tables and indexes. LibreOffice Writer also includes such useful features as a spellchecker, a thesaurus, 
AutoCorrect, and hyphenation as well as a variety of templates for almost every purpose. You can also create 
your own templates using the wizards.  

  

Saving in Multiple file format  

LibreOffice Writer supports multiple file format for saving and exporting a document. By Default, LibreOffice 
Writer uses OpenDocument format (ODF) but you can save your documents in multiple file formats. These 
formats can be as Text, Ritch Text, Office Open XML Text, Word 2007-2019, Word 2007-2019 VBA, Word 2003 
XML, Word 97-2003, DocBook, HTML Document, ODF Text Document template, Flat XML ODF Text Document, 
Unified Office Format Text and more.  

  

Designing and Structuring  

LibreOffice offers a wide variety of options to design documents. Use the Styles window to create, assign and 
modify styles for paragraphs, individual characters, frames and pages. In addition, the Navigator helps you to 
quickly move around inside your documents, lets you look at your document in an outline view, and keeps 
track of the objects that you have inserted into your document.  

You can also create various indexes and tables in text documents. You can define the structure and appearance 
of the indexes and tables according to your individual needs. Live hyperlinks and bookmarks let you jump 
directly to the corresponding items in the text.  

  

Desktop Publishing with LibreOffice Writer  

LibreOffice Writer contains numerous desktop publishing and drawing tools to assist you in creating 
professionally styled documents, such as brochures, newsletters and invitations. You can format your 
documents with multi-column layouts, text frames, graphics, tables, and other objects.  

  

Calculations  

Text documents in LibreOffice have an integrated calculation function that helps you execute sophisticated 
calculations or logical links. You can easily create a table in a text document in order to perform calculations.  

  
Creating Drawings  

The LibreOffice Writer drawing tool lets you create drawings, graphics, legends, and other types of drawings 
directly in text documents.  

  

Lesson - 2:  Writer 
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Inserting Graphics  

You can insert pictures with different formats into a text document, including graphics with a JPG or GIF 
format. In addition, the Gallery provides a collection of clipart graphics, and the Fontwork Gallery creates 
stunning font effects.  

  

Flexible Application Interface  

The program interface is designed so that you can configure it according to your preferences, including 
customizing icons and menus. You can position various program windows, such as the Styles window or the 
Navigator as floating windows anywhere on the screen. You can also dock some windows to the edge of the 
workspace.  

  

Interface- Writer  
LibreOffice writer interface is look like a Microsoft Word.  All menu, toolbars and commands managed 
according to Microsoft Word. Command icons are also displays and arranged at toolbars.  If you are  

 
Toolbars   
LibreOffice Writer provides multiple Toolbars to create a document. Each Toolbars have multiple commands 
that is related a group or functions.  Some important toolbar displays on the screen by default. You can use 
other toolbar through Toolbar command which is available on View menu. The Description of some important 
toolbar is as per given below:    

 Standard Bar: The Standard bar is available in every LibreOffice application.  

familiar with Microsoft Word, you can easily operate and work in LibreOffice writer.          

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

Minimize  
Button 

Close Button   

Maximize &   
           Restore Button   

Title Bar   

Horizontal Ruler   

Vertical Ruler   

View Button  

Zoom Level   
Horizontal Scroll Bar   

Status Bar   

Menu Bar   Standard Toolbar   

Formatting Toolbar   

Vertical Scroll Bar   

Text Properties    

Indent   
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 Formatting Bar: The Formatting bar contains several text 
formatting functions.  

 Drawing Bar: The Drawing bar contains frequently used 
editing tools. Click the arrow next to an icon to open a 
toolbar that contains additional commands.  

 Image Bar: The Image Bar contains functions for 
formatting and positioning selected bitmap graphics.  

 Frame Bar: When a frame is selected, the Frame Bar 
provides the most important functions for formatting and 
positioning the frame.  

 Table Bar: The Table Bar contains functions you need when 
working with tables. It appears when you move the 
cursor into a table.  

 Drawing Object Properties Bar: You can see the 
Drawing Object Properties bar in Writer and Calc. Select 
the menu View - Toolbars - Drawing Object 
Properties. The controls are enabled when a drawing 
object is selected. You see some different icons by 
default, whether the current document is a text 
document or a spreadsheet.  

 Bullets and Numbering Bar: The Bullets and 
Numbering bar contains functions to modify the 
structure of numbered paragraphs, including changing the order of paragraphs and defining different 
paragraph levels.  

 Text Object Bar: Contains formatting commands for text that is contained in a draw object. The Text 
Object bar appears when you double-click inside a draw object.  

 Status Bar: The Status Bar contains information about the current document and offers various 
buttons with special functions.  

 Print Preview: The Print Preview Bar appears when you view the current document in the print 
preview mode.  

 Rulers: Rulers display the dimensions of the page, and the position of tabs, indents, borders and 
columns. You can modify all of these on the rulers using the mouse.  

 Formula Bar: The Formula Bar allows you to create and insert calculations into a text document. To 
activate the Formula Bar, press F2.  

 Insert: The toolbar contains various functions for inserting frames, graphics, tables, and other objects.  
  

Menu Bar  
LibreOffice Writer’s Menu Bar is situated below title bar. All commands are stored in Menu Bar. Each menu 
displays command related to some special group. For example, File menu displays operations conducted on 
file, insert menu displays objects and text to be inserted. Like this Page Layout menu displays the layout setting 
of the document.  

File  

These commands apply to the current document, open a new document, or close the application.  

  

Edit  

This menu contains commands for editing the contents of the current document.  
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View  

This menu contains commands for controlling the on-screen display of the document.  

  

Insert  

The Insert menu contains commands for inserting new elements in your document. This includes images, 
media, charts, and objects from other applications, hyperlink, comments, symbols, footnotes, and sections.  

  

Format  

Contains commands for formatting the layout and the contents of your document.  

  

Styles  

Contains commands to apply, create, edit, update, load, and manage styles in a text document.  

  

Form  

Contains commands for activate form design mode, open control wizards and insert form controls in your text 
document.  

  

Table  

Shows commands to insert, edit, and delete a table and its elements inside a text document.  

  

Tools  

Contains spelling tools, a gallery of object art that you can add to your document, as well as tools for 
configuring menus, and setting program preferences.  

  

Window  

Contains commands for manipulating and displaying document windows.  

  

Help  

The Help menu allows you to start and control the LibreOffice Help system.  

  

FILE MENU  
The File menu's commands apply to the current document such as  open a new document, Create a new 
document, save document, print document, close application, etc.  

  

New  

This Command is used to create a new LibreOffice document. You can use Ctrl+N Shortcut key to create a new 
document or Ctrl+Shift+N to create a new template.  

  

Open  

This Command is used to pens a local or remote file, or imports one. You can use Ctrl+O Shortcut key to display 
open dialog box.   
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Open Remote...  

This Command is used to opens a document located in a remote file 
service.  

Recent Documents  

This Command is used to lists the most recently opened files. To open 
a file in the list, click its name.  

  

Close  

This Command is used to closes the current document without 
exiting the program.  

  

Wizards  

This Command is used to guides you through creating bus iness and 
personal letters, faxes, agendas, presentations, and more.  

  

Templates  

This Command is used to organize and edit your templates, as well 
as save the current file as a template.  

  

Reload  

This Command is used to replaces the current document with the last 
saved version.  

  

Versions  

This Command is used to Saves and organizes multiple versions of the 
current document in the same file. You can also open, delete and 
compare previous versions.  

  

Save  

This Command is used to Saves the current document. You can use 
Ctrl+S Shortcut key to save your document. Save Remote Command is used to Saves a document located in a 
remote file service.  

  
Save As  

This Command is used to Saves the current document in a different location, or with a different file name or 
file type. You can use Ctrl+Shift+S Shortcut key to save your document.  Save All Command is used to Saves all 
modified LibreOffice documents.  

  

Save a Copy  

This Command is used to Saves a copy of the actual document with another name or location.  

  

Export  

This Command is used to Saves the current document with a different name and format to a location that you 
specify.  
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Export As...  

This Command is used to Export the document in PDF or EPUB formats.  

  

Send  

This Command is used to Sends a copy of the current document to different applications.  

  

Preview in Web Browser  

This Command is used to Creates a temporary copy of the current document in HTML format, opens the system 
default Web browser, and displays the HTML file in the Web browser.  

  

Print Preview  

This Command is used to Displays a preview of the printed page or closes the preview. You can use Ctrl+Shift+O 
Shortcut key for this command.  

  

Print  

This Command is used to Prints the current document, selection, or the pages that you specify. You can also 
set the print options for the current document. The printing options can vary according to the printer and the 
operating system that you use. You can use Ctrl+P Shortcut key to print document.  

  

Printer Settings  

This Command is used to Select the default printer for the current document.  

  

Document Properties  

This Command is used to Displays the properties for the current file, including statistics such as word count 
and the date the file was created.  

  

Digital Signatures  

This Command is used to Adds and removes digital signatures to and from your document. You can also use 
the dialog to view certificates.  

  

Exit  

This Command is used to Closes all LibreOffice programs and prompts you to save your changes. This command 
does not exist on macOS systems. You can use Ctrl+Q Shortcut key for this command.  

  

EDIT MENU  
This menu contains commands for editing the contents of the current document.  

  

Undo  

Reverses the last command or the last entry you typed. To select the command that you want to reverse, 
click the arrow next to the Undo icon on the Standard bar. You can use shortcut key (Ctrl+Z) for this 
command.  

  

Redo  
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Reverses the action of the last Undo command. To select the Undo step that 
you want to reverse, click the arrow next to the Redo icon on the 
Standard bar. You can use shortcut key (Ctrl+Y) for this command.  

  

Repeat  

Repeats the last command. This command is available in Writer and Calc. 
You can use shortcut key (Ctrl+Shift+Y) for this command.  

  

Cut  

Removes and copies the selection to the clipboard. You can use 
shortcut key (Ctrl+X) for this command.  

  

Copy  

Copies the selection to the clipboard. You can use shortcut key (Ctrl+C) for 
this command.  

  

Paste  

Inserts the contents of the clipboard at the location of the cursor, and 
replaces any selected text or objects. You can use shortcut key (Ctrl+V) for 
this command.  

  

Paste Special  

Inserts the contents of the clipboard into the current file in a format that 
you can specify. You can use shortcut key (Ctrl+Shift+V) to paste Special and 
shortcut key (Ctrl+Alt+Shift+V) to paste unformatted text.  

  

Select All  

Selects the entire content of the current file, frame, or text object. You can use shortcut key (Ctrl+A) for this 
command.  

  

Selection Mode  

Choose the selection mode from the submenu: normal selection mode, or block selection mode. You can use 
shortcut key (Alt+Shift+F8) to block area in selection mode.   

  
Select Text  

You can enable a selection cursor in a read-only text document or in the Help. Choose Edit - Select Text or 
open the context menu of a read-only document and choose Select Text. The selection cursor does not blink. 
You can use shortcut key (Ctrl+Shift+I) for this command.  

  

Direct Cursor Mode  

Allows a user to click at the beginning, middle, or end of any possible text line on a page and then begin typing.  

  

Find  

Toggle the visibility of the Find toolbar to search for text or navigate a document by element. You can use 
shortcut key (Ctrl+F) for this command.  
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Find & Replace  

Finds or replaces text or formats in the current document. You can use shortcut key (Ctrl+H) for this command.  

  

Go to Page  

Opens the Navigator window on the Page Number spin button, so you can enter in a page number. You can 
use shortcut key (Ctrl+G) for this command.  

  

Track Changes  

Lists the commands that are available for tracking changes in your file.  

  

Hyperlink  

Opens a dialog that enables you to create and edit hyperlinks.  

  

Footnote or Endnote  

Edits the selected footnote or endnote anchor. Click in front of the footnote or endnote, and then choose this 
command.  

  

Index Entry  

Edits the selected index entry. Click in front of or in the index entry, and then choose this command.  

  

Bibliography Entry  

Edits the selected bibliography entry.  

  

Fields  

Opens a dialog where you can edit the properties of a field. Click in front of a field, and then choose this 
command. In the dialog, you can use the arrow buttons to move to the previous or the next field.  

  

Links  

Lets you edit the properties of each link in the current document, including the path to the source file. This 
command is not available if the current document does not contain links to other files.  
Image Map  

Allows you to attach URLs to specific areas, called hotspots, on a graphic or a group of graphics. An image map 
is a group of one or more hotspots.  

  

Object  

Lets you edit a selected object in your file that you inserted with the Insert - Object command.  

  

Exchange Database  

Change the data sources for the current document. To correctly display the contents of inserted fields, the 
replacement database must contain identical field names.  

  

Edit File  
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Use the Edit File icon to activate or deactivate the edit mode.  

  

VIEW MENU  
This menu contains commands for controlling the on-screen display of the document.  

  

Normal  

Displays how the document will look when you print it.  

  

Web  

Displays the document as it would be viewed in a Web browser. This is 
useful when you create HTML documents.  

  

Toolbars  

Opens a submenu to show and hide toolbars. A toolbar contains icons 
and options that let you quickly access LibreOffice commands.  

  

Status Bar  

Shows or hides the Status bar at the bottom edge of the window.  

  

Rulers  

Contains a submenu for showing or hiding the horizontal and vertical 
rulers. You can use shortcut key (Ctrl+Shift+R) to show and hide rulers  

  

Scrollbars  

Show or hide the horizontal and vertical scroll bars that are used to 
change the viewable area of a document that doesn't fit within the 
window.  

  

Text Boundaries  

Shows or hides the boundaries of the printable area of a page. The 
boundary lines are not printed.  

  
Table Boundaries  

Shows or hides the borders of table cells that have no set borders. The boundaries are only visible on screen 
and are not printed.  

  

Images and Charts  

Show or hide graphical objects like images and charts within a document.  

  

Comments  

Show or hide a document's comments and replies to them.  

  

Formatting Marks  
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Shows hidden formatting symbols in your text, such as paragraph marks, line breaks, tab stops, and spaces. 
You can use shortcut key (Ctrl+F10) for this command.  

  

Grid and Help Lines  

Toggle the visibility of grid points and guide lines to help object moving and precise position in the current 
sheet.  

  

Hide Whitespace  

View documents with the white space found at the end and beginning of pages hidden.  

  

Track Changes  

Shows or hides recorded changes.  

  

Field Shadings  

Shows or hides shadings around fields in your document like non-breaking spaces, soft hyphens, indexes, and 
footnotes. You can use shortcut key (Ctrl+F8) for this command.  

  

Field Names  

Switches between showing fields as field names or field values. When enabled the field names are displayed, 
and when disabled the field values displayed. Some field contents cannot be displayed. You can use shortcut 
key (Ctrl+F9) for this command.  

  

Sidebar  

The Sidebar is a vertical graphical user interface that primarily provides contextual properties, style 
management, document navigation, and media gallery features. You can use shortcut key (Ctrl+F5) for this 
command.  

  

Styles  

Use the Styles deck of the Sidebar to apply, create, edit, and remove formatting styles. Double-click an entry 
to apply the style. You can use shortcut key (F11) for this command.  

  

Gallery  

Opens the Gallery deck of the Sidebar, where you can select images and audio clips to insert into your 
document.  

  
Navigator  

Shows or hides the Navigator window, where you can quickly jump to different parts of your document. 
Navigator is also available as a deck of the Sidebar. You can also use the Navigator to insert elements from the 
current document or other open documents, and to organize master documents. To edit an item in the 
Navigator, right-click the item, and then choose a command from the context menu. If you want, you can dock 
the Navigator at the edge of your workspace. You can use shortcut key (F5) for this command.  

  

Data Sources  

Lists the databases that are registered in LibreOffice and lets you manage the contents of the databases. You 
can use shortcut key (Ctrl+Shift+F4) for this command.  
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Full Screen  

Shows or hides the menus and toolbars in Writer or Calc. To exit the full screen mode, click the Full Screen 
button or press the Esc key. You can use shortcut key (Ctrl+Shift+J) for this command.  

  

INSERT MENU  
The Insert menu contains commands for inserting new elements in your 
document. This includes images, media, charts and objects from other 
applications, hyperlink, comments, symbols, footnotes, and sections.  

  

Page Break  

Inserts a manual page break at the current cursor position and places the 
cursor at the beginning of the next page. You can use shortcut key 
(Ctrl+Enter) for this command.  

  

Manual Break  

Inserts a manual line break, column break or a page break at the current 
cursor position.  

  

Image   

Inserts an image into the current document with optimal page wrapping and 
centered on the line.  

  

Media  

The submenu presents various sources that an image, audio or video can be 
insert from.  

  

Chart  

Inserts a chart based on data or table range or with default data.  

  

Object  

Inserts an embedded object into your document, including formulas, 3D models, charts and OLE objects.  

  
Shape  

This submenu contains common shapes like a line, circle, triangle, and square, or a symbol shape like a smiley 
face, heart, and flower that can be inserted into the document.  

  

Fontwork  

Opens the Fontwork dialog from which you can insert styled text not possible through standard font 
formatting into your document.  

  

Textbox  
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Draws a text box with horizontal text direction where you drag in the current document. Drag a text box to 
the size you want anywhere in the document, and then type or paste your text. Rotate the text box to get 
rotated text.  

  

Comment  

Inserts a comment around the selected text or at the current cursor position. You can use shortcut key 
(Ctrl+Alt+C) for this command.  

  

Frame  

This submenu contains both interactive and non-interactive means of inserting a frame.  

  

Caption  

Adds a numbered caption to a selected image, table, chart, frame, or shape. You can also access this command 
by right-clicking the item that you want to add the caption to.  

  

Hyperlink  

Opens a dialog that enables you to create and edit hyperlinks. You can use shortcut key (Ctrl+K) for this 
command.  

  

Bookmark  

Inserts a bookmark at the cursor position. You can then use the Navigator to quickly jump to the marked 
location at a later time. In an HTML document, bookmarks are converted to anchors that you can jump to from 
a hyperlink.  

  

Cross-references  

This is where you insert the references or referenced fields into the current document. References are 
referenced fields within the same document or within sub-documents of a master document.  

  

Special Character  

Allows a user to insert characters from the range of symbols found in the installed fonts.  

  

Formatting Mark  

Opens a submenu to insert special formatting marks like non-breaking space, soft hyphen, and optional break.  

  
Horizontal Line  

Inserts a horizontal line at the current cursor position.  

  

Footnote and Endnote  

The menu contains commands to insert a footnote or endnote with or without additional user interaction.  

  

Table of Contents and Index  

Opens a menu to insert an index or bibliography entry, as well as inserting a table of contents, index, and or 
bibliography.  
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Page Number  

Inserts the current page number as a field at the cursor position. The default setting is for it to use the Page 
Number character style.  

  

Fields  

The submenu lists the most common field types that can be inserted into a document at the current cursor 
position. To view all of the available fields, choose More Fields.  

  

Header and Footer  

This submenu includes commands to add and remove page headers and footers.  

  

Section  

Inserts a text section at the cursor position in the document. You can also select a block of text and then choose 
this command to create a section. You can use sections to insert blocks of text from other documents, to apply 
custom column layouts, or to protect or to hide blocks of text if a condition is met.  

  

Envelope  

Creates an envelope. On three tab pages, you can specify the addressee and sender, the position and format 
for both addresses, the size of the envelope, and the envelope orientation.  

  

Document  

Inserts the contents of another document into the current document at the cursor position.  

  

Script  

Inserts a script at the current cursor position in an HTML or text document.  

  

Form Control  

This submenu contains form controls like a textbox, checkbox, option button, and list box that can be inserted 
into the document.  

  

  
  
FORMAT MENU  
Contains commands for formatting the layout and the contents of your document.  

  

Text   

You can format the selected text as per your requirement. You can format the text as bold (Ctrl+B), Italic 

(Ctrl+I), Underline (Ctrl+U), Double underline  (Ctrl+D),  Superscript  (Ctrl+Shift+P), Subscript 

(Ctrl+Shift+B), Chage Case (Shift+F3), etc.   

    

Spacing  
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This command is used to set the line spacing in 
selected text or paragraph.   

  

Align  

This command is used to align the selected text or 
paragraph.  You can use Ctrl+L key to left align, Ctrl+R 
key to right align, Ctrl+E key to center align and Ctrl+J key to 
justify.    

  

Lists  

This command is used to create a bulleted or 
numbered list.    

  

Clear Direct Formatting  

Removes direct formatting and formatting by 
character styles from the selection.  

  

Character  

Changes the font and the font formatting for the 
selected characters.  

  

Paragraph  

Modifies the format of the current paragraph, such as indents and alignment.  

  

Bullets and Numbering  

Adds numbering or bullets to the current paragraph, and lets you edit format of the numbering or bullets.  

  

Page  

Specify the formatting styles and the layout for the current page style, including page margins, headers and 
footers, and the page background.  

  

Columns  

Specifies the number of columns and the column layout for a page style, frame, or section.  
Image  

Formats the size, position, and other properties of the selected image.   

  

Frame and Object  

Inserts a frame that you can use to create a layout of one or more columns of text and objects.   

  

Anchor  

Sets the anchoring options for the selected object.  

  

Wrap  
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Specify the way you want text to wrap around an object. You can also specify the spacing between the text 
and the object.  

  

Arrange  

Changes the stacking order of the selected object(s).  

  

Flip  

Flips the selected object horizontally, or vertically.  

  

Group  

Groups keep together selected objects, so that they can be moved or formatted as a single object.  

  

STYLE MENU  
Contains commands to apply, create, edit, update, load, and manage styles in a text document.  

  

Edit Style  

Opens the Paragraph Style dialog box of the current paragraph.  

  

Update Style  

Update the paragraph style with the direct formatting applied to the 

current paragraph. You can use shortcut key (Ctrl+Shift+F11) for this 

command.  

  

New style  

Adds a paragraph style with the settings of the current selection. You 
will be prompted to enter the style name. You can use shortcut key 
(Shift+F11) for this command.  

  

Load Styles  

Import styles from another document or template into the current document.  

  

Manage Styles  

Opens the Styles deck in the sidebar. You can use shortcut key (F11) for this command.  

  

TABLE MENU  
Shows commands to insert, edit, and delete a table and its elements inside a text document.  

  

Insert Table  

This command is used to insert a new table. You can use Ctrl+F12 shortcut key for this command.    

  

Insert  

This command is used to insert a row or columns in a table.   
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Delete  

This command is used to delete row, columns or current table.   

  

Select  

This command is used to select row, columns or current table.   

  

Merge Cells  

Combines the contents of the selected table cells into a single cell.  

  

Split Cells  

Splits the cell or group of cells horizontally or vertically into the 
number of cells that you enter.  

  

Merge Table  

Combines two consecutive tables into a single table. The tables must 
be directly next to each other and not separated by an empty 
paragraph.  

  

Split Table  

Splits the current table into two separate tables at the cursor position. You can also access this command by 
right-clicking in a table cell.  

  

Table AutoFormat  

Automatically applies formats to the current table, including fonts, shading, and borders.  

  

Repeat Heading Rows  

Repeats the table headers on subsequent pages if the table spans one or more pages.  

  

Convert  

This command is used to convert Text to Table and Table to Text  

  

Sort  

Sorts the selected paragraphs or table rows alphabetically or numerically. You can define up to three sort keys 
as well as combine alphanumeric and numeric sort keys.  
Formula  

Opens the Formula bar to enter or edit a formula. You can use F2 function key for this command.  

  

Number Format  

Opens a dialog where you can specify the format of numbers in the table.  

  

Table Properties  
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Specifies the properties of the selected table, for example, name, alignment, spacing, column width, borders, 
and background.  

  

FORM MENU  
Contains commands for activate form design mode, open control wizards and insert form controls in your text 
document.  

  

Design Mode   

Enable or disable form design mode.  

  

Control Wizards  

Enable or disable control wizards.  

  

Label Field  

Adds a field for displaying text labels. These labels are only for displaying 
predefined text, and not for entering text.  

  

Text Box  

Adds an input box where you can enter and edit text.  

  

Check Box  

Adds a check box that you can use to turn a function on or off.  

  

Option Button  

Adds a button that allows a user to select from a number of options. 
Grouped option buttons must have consecutive tab indices. They are 
commonly encircled by a group box. If you have two groups of option 
buttons, you must insert a tab index between the tab indices of the two 
groups on the group frame.  

  

Combo Box  

Adds a combo box. A combo box is a one line list box that a user can click, and then choose an entry from the 
list. If you want, you can make the entries in the combo box "read only".  

  

Button  

Adds a command button. You can use a command button to execute a command for a defined event, such as 
a mouse click. If you want, you can add text or a graphic to the button.  
Formatted Field  

Adds a text box where you can define the formatting for text that is inputted or outputted as well as any 
limiting values.  

  

More fields  

Date, time, numerical, currency and pattern form fields.  
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Group Box  

Adds a frame that you can use to visually group similar controls, such as option buttons.  

  

File Selection  

Adds a button that opens a file selection dialog.  

  

Control Properties  

Opens a dialog for editing the properties of a selected control.  

  

Form Properties  

In this dialog you can specify, among others, the data source and the events for the whole form.  

  

Form Navigator  

Opens the Form Navigator. The Form Navigator displays all forms and subforms of the current document with 
their respective controls.  

  

Tab order  

When a form is selected, it opens the Tab Order dialog, where the indices for focusing the control elements 
on the Tab key are defined.  

  

Open in Design Mode  

Opens forms in Design Mode so that the form can be edited.  

  

Automatic Control Focus  

Enable or disable Automatic Control Focus   

  

TOOLS MENU  
Contains spelling tools, a gallery of object art that you can add to your document, as well as tools for 
configuring menus, and setting program preferences.  

  

Spellcheck  

Checks spelling manually. You can also use F7 Function Key for this command  

  

Language  

Opens a submenu where you can choose language specific commands.  
Word Count  

Counts the words and characters, with or without spaces, in the current selection and in the whole document. 
The count is kept up to date as you type or change the selection.  

  

AutoCorrect Options  

Sets the options for automatically replacing text as you type.   

  

AutoText  
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Creates, edits, or inserts AutoText. You can store formatted text, 
text with graphics, tables, and fields as AutoText. To quickly insert 
AutoText, type the shortcut for the AutoText in your 
document, and then press Ctrl+F3.  

  

Chapter Numbering  

Specifies the number format and the hierarchy for chapter 
numbering in the current document.  

  

Line Numbering  

Adds or removes and formats line numbers in the current 
document. To exclude a paragraph from line numbering, click in the 
paragraph, choose Format - Paragraph, click the Numbering tab, 
and then clear the Include this paragraph in line numbering check 
box.  

  

Footnotes and Endnotes  

Specifies the display settings for footnotes and endnotes.  

  

Bibliography Database  

Insert, delete, edit, and organize records in the bibliography 
database.  

  

Mail Merge Wizard  

Starts the Mail Merge Wizard to create form letters or send e-mail messages to many recipients.  

  

Update  

Updates items in the current document that have dynamic contents, so as fields and indexes.  

  

Sort  

Sorts the selected paragraphs or table rows alphabetically or numerically. You can define up to three sort keys 
as well as combine alphanumeric and numeric sort keys.  

  

Calculate  

Calculates the selected formula and copies the result to the clipboard. You can also use Ctrl++ Shortcut Key 
for this command.  
Macros  

Lets you record or organize and edit macros.  

  

XML Filter Settings  

Opens the XML Filter Settings dialog, where you can create, edit, delete, and test filters to import and to export 
XML files.  

  

Extension Manager  
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The Extension Manager adds, removes, disables, enables, and updates LibreOffice extensions. You can also 
use Ctrl+Alt+E Shortcut Key for this command.  

  

Customize  

Customizes LibreOffice menus, context menus, shortcut keys, toolbars, and macro assignments to events.  

  

Options  

This command opens a dialog for a customized program configuration. You can also use Alt+F12 Shortcut Key 
for this command.  

  

WINDOW MENU  
Contains commands for manipulating and displaying document windows.  

  

New Window  

Opens a new window that displays the contents of the current 
window. You can now view different parts of the same 
document at the same time.  

  

Close Window  

Closes the current window. Choose Window - Close Window, or press Ctrl+F4. In the print preview of 
LibreOffice Writer and Calc, you can close the current window by clicking the Close Preview button.  

  

Document List  

Lists the currently open documents. Select the name of a document in the list to switch to that document.  

  

HELP MENU  
The Help menu allows you to start and control the LibreOffice Help system.   

  

LibreOffice Help  

Opens the main page of the LibreOffice Help for the current application. You can scroll through the Help 

pages and you can search for index terms or any text. You can also use F1 function ket for this command.  

What's this?  

Enables extended help tips under the mouse pointer till the next click.  

  

User Guides  

Opens the documentation page in the web browser, where users can download, read or purchase LibreOffice 
user guides, written by the community.  

  

Get Help Online  

Opens the community support page in the web browser. Use this page to ask questions on using LibreOffice. 
For professional support with service level agreement, refer to the page of professional LibreOffice support.  

  

Send Feedback  
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Opens a feedback form in the web browser, where users can 
report software bugs.  

  

Restart in Safe Mode  

Safe mode is a mode where LibreOffice temporarily starts with a fresh 
user profile and disables hardware acceleration. It helps to 
restore a non-working LibreOffice instance.  

  

License Information  

Displays the Licensing and Legal information dialog.  

  

LibreOffice Credits  

Displays the CREDITS.odt document which lists the names of 
individuals who have contributed to OpenOffice.org source code 
(and whose contributions were imported into LibreOffice) or 
LibreOffice since 2010-09-28.  

  

Check for Updates  

Enable an Internet connection for LibreOffice. If you need a Proxy, check the LibreOffice Proxy settings in Tools 
- Options - Internet. Then choose Check for Updates to check for the availability of a newer version of your 
office suite.  

  

About LibreOffice  

Displays general program information such as version number and copyrights.  

  

  

  

 
  

  

 

  

  

  

LibreOffice Calc is a spreadsheet application that you can use to calculate, analyze, and manage your data. You 
can also import and modify Microsoft Excel spreadsheets.  

  

Calculations  

LibreOffice Calc provides you with functions, including statistical and banking functions, that you can use to 
create formulas to perform complex calculations on your data. You can also use the Function Wizard to help 
you create your formulas.  

  

What-If Calculations  

Lesson - 3:  Calc 
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An interesting feature is to be able to immediately view the results of changes made to one factor of 
calculations that are composed of several factors. For instance, you can see how changing the time period in 
a loan calculation affects the interest rates or repayment amounts. Furthermore, you can manage larger tables 
by using different predefined scenarios.  

  

Database Functions  

Use spreadsheets to arrange, store, and filter your data. LibreOffice Calc lets you drag-and-drop tables from 
databases, or lets you use a spreadsheet as a data source for creating form letters in LibreOffice Writer.  

  

Arranging Data  

With a few mouse-clicks, you can reorganize your spreadsheet to show or hide certain data ranges, or to 
format ranges according to special conditions, or to quickly calculate subtotals and totals.  

  

Dynamic Charts  

LibreOffice Calc lets you present spreadsheet data in dynamic charts that update automatically when the data 
changes.  

  

Opening and Saving Microsoft Files  

Use the LibreOffice filters to convert Excel files, or to open and save in a variety of other formats.  

  

Interface- Calc  
LibreOffice Calc interface is look like a Microsoft Excel.  All menu, toolbars and commands managed according 
to Microsoft Excel. Command icons are also displays and arranged at toolbars.  If you are familiar with 
Microsoft Excel, you can easily operate and work in LibreOffice Calc.  
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Electronic worksheet is made up of combination of row and column. LibreOffice Calc has below limits for 
number of rows, columns and cells that it can handle.  

 Maximum number of Columns per worksheet = 1024 (Col A to AMJ).  

 Maximum number of Rows per worksheet = 1048576 (1,2,3….)  

 Maximum number of cells per worksheet = 1,073,741,824 (2^30).  

 Maximum number of characters in one cell = 32767  

 Maximum number of worksheets in a workbook = 10000  

  

Cell and Active Cell  

In the electronic worksheet, the rectangular figure made by intersection of row and column is called cell. This 
is the smallest unit of electronic worksheet in which data is stored. There is an address of every cell in the 
worksheet. The address of first cell is (A1) and of next cell is (B1). This address is very important because cell 
address is needed for calculation by formula. If in any cell more numeric data is typed than its size then we 
will have to increase the width of that cell. You can store text in a cell in more than one line. If a rectangle 
border is visible on a cell, it is called active cell. This rectangular border is called cell pointer. Any cell can be 
made active by clicking mouse or arrow key. In the picture given above, there is a border displayed around cell 
B10.  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

Title Bar   

Zoom Level   

Horizontal Scroll Bar   
Status Bar   

Properties Toolbar   

Vertical Scroll Bar   

Control Menu   
Menu Bar   Standard Toolbar   Formula Toolbar   Formatting Toolbar   

Column Heading   

Row   Heading   

Active Cell   

Sheet Tabs   

Name Box   
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Menus  
The window containing the document you want to work on must be selected in order to use the menu 
commands. Similarly, you must select an object in the document to use the menu commands  

 
File  

These commands apply to the current document, open a new document, or close the application.  

  

Edit  

This menu contains commands for editing the contents of the current document.  

  

View  

This menu contains commands for controlling the on-screen display of the document.  

  

Insert  

The Insert menu contains commands for inserting new elements, such as cells, rows, sheets and cell names 
into the current sheet.  

  

Format  

The Format menu contains commands for formatting selected cells, objects, and cell contents in your 
document.  

  

Sheet  

This menu contains commands to modify and manage a sheet and its elements.  

  

Data  

Use the Data menu commands to edit the data in the current sheet. You can define ranges, sort and filter the 
data, calculate results, outline data, and create a pivot table.  

  

Tools  

The Tools menu contains commands to check spelling, to trace sheet references, to find mistakes and to define 
scenarios.  

  

Window  

Contains commands for manipulating and displaying document windows.  

  

Help  

The Help menu allows you to start and control the LibreOffice Help system.  

  

associated with  the object. The following menu commands are available for spreadsheets.   
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FILE MENU  
These commands apply to the current document, open a new document, or close the application.  

  

New  

Creates a new LibreOffice document. You can use Shortcut key (Ctrl+N) to 
create a new spreadsheet. If you are creating a new template, then use 
Shortcut key (Ctrl+Shift+N).  

  

Open  

Opens a local or remote file, or imports one. You can use Shortcut key 
(Ctrl+O) for this command.  

  

Recent Documents   

Lists the most recently opened files. To open a file in the list, click its 
name.  

  

Close  

Closes the current document without exiting the program.  

  

Wizards  

Guides you through creating business and personal letters, faxes, 
agendas, presentations, and more.  

  

Templates  

Lets you organize and edit your templates, as well as save the current file as 
a template.  

  

Reload  

Replaces the current document with the last saved version.  

  

Versions  

Saves and organizes multiple versions of the current document in the same file. You can also open, delete and 
compare previous versions.  

  

Save  

Saves the current document. You can use Shortcut key (Ctrl+S) for this command.  

  

Save As  

Saves the current document in a different location, or with a different file name or file type. You can use 
Shortcut key (Ctrl+Shift+S) for this command.  

  

Save All  



UPCISS 
 

32 
 

Saves all modified LibreOffice documents.  

  
Export  

Saves the current document with a different name and format to a location that you specify.  

  

Export as PDF  

Saves the current file to Portable Document Format (PDF) version 1.4. A PDF file can be viewed and printed on 
any platform with the original formatting intact, provided that supporting software is installed.  

  

Send  

Sends a copy of the current document to different applications.  

  

Preview in Web Browser  

Creates a temporary copy of the current document in HTML format, opens the system default Web browser, 
and displays the HTML file in the Web browser.  

  

Print Preview  

Displays a preview of the printed page or closes the preview. You can use Shortcut key (Ctrl+Shift+O) for this 
command.  

  

Print  

Prints the current document, selection, or the pages that you specify. You can also set the print options for 
the current document. The printing options can vary according to the printer and the operating system that 
you use. You can use Shortcut key (Ctrl+P) for this command.  

  

Printer Settings  

Select the default printer for the current document.  

  

Document Properties  

Displays the properties for the current file, including statistics such as word count and the date the file was 
created.  

  

Digital Signatures  

Adds and removes digital signatures to your document. You can also use the dialog to view certificates.  

  

Exit  

Closes all LibreOffice programs and prompts you to save your changes. This command does not exist on macOS 
systems. You can use Shortcut key (Ctrl+Q) for this command.  

  

EDIT MENU  
This menu contains commands for editing the contents of the current document.  

  

Undo  
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Reverses the last command or the last entry you typed. To select the 
command that you want to reverse, click the arrow next to the Undo 
icon on the Standard bar. You can use Shortcut key (Ctrl+Z) for this 
command.  
Redo  

Reverses the action of the last Undo command. To select the Undo step 
that you want to reverse, click the arrow next to the Redo icon on the 
Standard bar. ou can use Shortcut key (Ctrl+Y) for this command.  

  

Repeat   

Repeats the last command. This command is available in Writer and Calc. 
ou can use Shortcut key (Ctrl+Shift+Y) for this command.  

  

Cut  

Removes and copies the selection to the clipboard.  You can use 
Shortcut key (Ctrl+X) for this command.  

  

Copy  

Copies the selection to the clipboard. You can use Shortcut key 
(Ctrl+C) for this command.  

  

Paste  

Inserts the contents of the clipboard at the location of the cursor, and 
replaces any selected text or objects. You can use Shortcut key (Ctrl+V) for this command.  

  

Paste Special  

Inserts the contents of the clipboard into the current file in a format that you can specify.  

  

Select All  

Selects the entire content of the current file, frame, or text object. You can use Shortcut key (Ctrl+Shift+Space) 
for this command.  

  

Find  

Toggle the visibility of the Find toolbar to search for text or navigate a document by element. You can use 
Shortcut key (Ctrl+F) for this command.  

  

Find & Replace  

Finds or replaces text or formats in the current document. You can use Shortcut key (Ctrl+H) for this command.  

  

Track Changes  

Lists the commands that are available for tracking changes in your file.  

  

Links  
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Lets you edit the properties of each link in the current document, including the path to the source file. This 
command is not available if the current document does not contain links to other files.  
ImageMap  

Allows you to attach URLs to specific areas, called hotspots, on a graphic or a group of graphics. An image map 
is a group of one or more hotspots.  

  

Object  

Lets you edit a selected object in your file that you inserted with the Insert - Object command.  

  

Edit File  

Use the Edit File icon to activate or deactivate the edit mode. You can use Shortcut key (Ctrl+Shift+M) for this 
command.  

  

VIEW MENU  
This menu contains commands for controlling the on-screen display of the document.  

  

Normal  

Displays the normal layout view of the sheet.  

  

Page Break  

This command is used to insert a page break in your worksheet.  

  

Formula Bar  

Shows or hides the Formula Bar, which is used for entering and 
editing formulas. The Formula Bar is the most important tool when 
working with spreadsheets.  

  

View Headers  

This command is used to Shows column headers and row 
headers.  

  

View Grid Lines  

Toggle the visibility of grid lines for the current sheet.  

  

Status Bar  

Shows or hides the Status bar at the bottom edge of the window.  

  

Value Highlighting  

Displays cell contents in different colors, depending on type. You can 
use Shortcut key (Ctrl+F8) for this command.  

  

Show Formula  
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Display the cell formula expression instead of the calculated result. You can use Ctrl key to show formula of 
selected cell.  

  

  
Grid and Help Lines  

Toggle the visibility of grid points and guide lines to help object moving and precise position in the current 
sheet.  

  

Freeze Rows and Columns  

Divides the sheet at the top left corner of the active cell and the area to the top left is no longer scrollable.  

  

Split Window  

Divides the current window at the top left corner of the active cell.  

  

Sidebar  

The Sidebar is a vertical graphical user interface that primarily provides contextual properties, style 
management, document navigation, and media gallery features. You can use Shortcut key (Ctrl+F5) for this 
command.  

  

Styles  

Use the Styles deck of the Sidebar to assign styles to cells and pages. You can apply, update, and modify existing 
styles or create new styles. You can use function key (F11) for this command.  

  

Gallery  

Opens the Gallery deck of the Sidebar, where you can select images and audio clips to insert into your 
document.  

  

Navigator  

Activates and deactivates the Navigator. The Navigator is a dockable window. You can use function key (F5) 
for this command.  

  

Function List  

Opens the Function List deck of the Sidebar, which displays all functions that can be inserted into your 
document.  

  

Data Sources  

Lists the databases that are registered in LibreOffice and lets you manage the contents of the databases. You 
can use Shortcut key (Ctrl+Shift+F4) for this command.  

  

Full Screen  

Shows or hides the menus and toolbars in Writer or Calc. To exit the full screen mode, click the Full Screen 
button or press the Esc key. You can use Shortcut key (Ctrl+Shift+J) for this command.  

  

Zoom  
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Reduces or enlarges the screen display of LibreOffice.  

  

  

INSERT MENU  
The Insert menu contains commands for inserting new elements, such as cells, rows, sheets and cell names 
into the current sheet.  

  

Media  

The submenu presents various sources that an image, audio or video can be 
insert from. You can Inserts a video or audio file into your document.  

  

Chart  

This command is used to Inserts a chart in worksheet.  

  

Object  

Inserts an embedded object into your document, including formulas, 3D 
models, charts and OLE objects.  

  

Special Character  

Allows a user to insert characters from the range of symbols found in the 
installed fonts.  

  

Formatting Mark  

Opens a submenu to insert special formatting marks like non-breaking space, 
soft hyphen, and optional break.  

  

Hyperlink  

Opens a dialog that enables you to create and edit hyperlinks. You can use Shortcut key (Ctrl+K) for this 
command.  

  

Function  

Opens the Function Wizard, which helps you to interactively create formulas. You can use Shortcut key 
(Ctrl+F2) for this command.  

  

Named Ranges and Expressions  

Allows you to name the different sections of your spreadsheet document. By naming the different sections, 
you can easily navigate through the spreadsheet documents and find specific information.  

  

Comment  

Inserts a comment around the selected text or at the current cursor position. You can use Shortcut key 
(Ctrl+Alt+C) for this command.  

  

Floating Frame  
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Inserts a floating frame into the current document. Floating frames are used in HTML documents to display 
the contents of another file.  

  

Headers & Footers  

Allows you to define and format headers and footers.  

FORMAT MENU  
The Format menu contains commands for formatting selected cells, objects, and cell contents in your 
document.  

  

Clear Direct Formatting  

Removes direct formatting and formatting by character styles from the 
selection.  

  

Cells  

Allows you to specify a variety of formatting options and to apply attributes to the 
selected cells.  

  

Row  

Sets the row height and hides or shows selected rows.  

  

Column  

Sets the column width and hides or shows selected columns.  

  

Sheet  

Sets the sheet name and hides or shows selected sheets.  

  

Merge and Center Cells  

Combines the selected cells into a single cell or splits merged cells. Aligns cell 
content centered.  

  

Page  

Opens a dialog where you can define the appearance of all pages in your document.  

  

Print Ranges  

Manages print ranges. Only cells within the print ranges will be printed.  

  

Character  

Changes the font and the font formatting for the selected characters.  

  

Paragraph  

Modifies the format of the current paragraph, such as indents and alignment.  

  

Change Case  
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Changes the case of characters in the selection. If the cursor is within a word and no text is selected, then the 
word is the selection.  

  

AutoFormat  

Use this command to apply an AutoFormat to a selected sheet area or to define your own AutoFormats.  
Conditional Formatting  

Choose Conditional Formatting to define format styles depending on certain conditions.  

  

Anchor  

Sets the anchoring options for the selected object.  

  

Arrange  

Changes the stacking order of the selected object(s).  

  

Flip  

Flips the selected object horizontally, or vertically.  

  

Group  

Groups keep together selected objects, so that they can be moved or formatted as a single object.  

  

SHEET MENU  
This menu contains commands to modify and manage a sheet and its elements.  

  

Insert Rows  

Insert rows above or below the active cell.  

  

Insert Columns  

Inserts columns to the left or to the right of the active cell.  

  

Insert Page Break  

This command inserts manual row or column breaks to ensure that your data prints properly. You can insert a 
horizontal page break above, or a vertical page break to the left of, the active cell.  

  

Delete Cells  
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Completely deletes selected cells, columns or rows. The cells below or to the 
right of the deleted cells will fill the space. Note that the selected delete 
option is stored and reloaded when the dialog is next called. You can use 
Shortcut key (Ctrl+-) for this command.  

  

Delete Page Break  

Choose the type of page break that you want to delete.  

  

Fill  

Automatically fills cells with content.  

  

Deleting Contents  

Specifies the contents to be deleted from the active cell or from a 
selected cell range. If several sheets are selected, all selected sheets will be 
affected.  
Move or Copy Sheet  

Moves or copies a sheet to a new location in the document or to a 
different document.  

  

Show Sheet  

Displays sheets that were previously hidden with the Hide Sheets 
command.  

  

Delete Sheet  

Deletes the current sheet after query confirmation.  

  

Sheet Tab Color  

Opens a window where you can assign a color to the sheet tab.  

  

Sheet Events  

Assigns macros to program events. The assigned macro runs automatically every time the selected event 
occurs.  

  

DATA MENU  
Use the Data menu commands to edit the data in the current sheet. You can define ranges, sort and filter the 
data, calculate results, outline data, and create a pivot table.  

  

Sort  

Sorts the selected rows according to the conditions that you specify.  

  

Filter  

Shows commands to filter your data.  

  

Define Range  
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Defines a database range based on the selected cells in your sheet.  

  

Select Range  

Selects a database range that you defined under Data - Define Range.  

  

Refresh Range  

Updates a data range that was inserted from an external database. The data 
in the sheet is updated to match the data in the external database.  

  

Pivot Table  

A pivot table provides a summary of large amounts of data. You can then 
rearrange the pivot table to view different summaries of the data.  

  

Subtotals  

Calculates subtotals for the columns that you select.  

  
Validity  

Defines what data is valid for a selected cell or cell range.  

  

Multiple Operations  

Applies the same formula to different cells, but with different parameter values.  

  

Text to Columns  

Opens the Text to Columns dialog, where you enter settings to expand the 
contents of selected cells to multiple cells.  

  

Consolidate  

Combines data from one or more independent cell ranges and calculates a new range using the function that 
you specify.  

  

Group and Outline  

You can create an outline of your data and group rows and columns together so that you can collapse and 
expand the groups with a single click.   

  

TOOLS MENU  
The Tools menu contains commands to check spelling, to trace sheet references, to find mistakes and to define 
scenarios. You can also create and assign macros and configure the look and feel of toolbars, menus, keyboard, 
and set the default options for LibreOffice applications.  

  

Spellcheck  

Checks spelling manually. You can uses Function key (F7) for this command.  

  

Language  
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Opens a submenu where you can choose language specific 
commands.  

  

AutoCorrect Options  

Sets the options for automatically replacing text as you type.  

  

Goal Seek   

Opens a dialog where you can solve an equation with a 
variable.  

  

Solver  

Opens the Solver dialog. A solver allows you to solve 
equations with multiple unknown variables by goal-seeking 
methods.  

  

  
Detective  

This command activates the Spreadsheet Detective. With the 
Detective, you can trace the dependencies from the current formula 
cell to the cells in the spreadsheet.  

  

Scenarios  

Defines a scenario for the selected sheet area.  

  

Protect Document  

The Protect Sheet or Protect Spreadsheet Structure commands prevent changes from being made to cells in 
the sheets or to sheets in a document. As an option, you can define a password. If a password is defined, 
removal of the protection is only possible if the user enters the correct password.  

  

Macros  

Lets you record or organize and edit macros.  

  

Extension Manager  

The Extension Manager adds, removes, disables, enables, and updates LibreOffice extensions. You can use 
shortcut key (Ctrl+Alt+E) for this command.  

  

XML Filter Settings  

Opens the XML Filter Settings dialog, where you can create, edit, delete, and test filters to import and to export 
XML files.  

  

Customize  

Customizes LibreOffice menus, context menus, shortcut keys, toolbars, and macro assignments to events.  

  

Options  
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This command opens a dialog for a customized program configuration. You can use shortcut key (Alt+F12) for 
this command.  

  

 
  

  

In LibreOffice Calc program, you can get desired results of computation related work with the help of 

formula and function. Different operators are used for calculation by formula. Besides this, some predefined 

functions are given in Calc by using them desired result can be obtained.   

  

Using Formulas  
In LibreOffice Calc, you can use formula to analyze the data in the worksheet. With one formula you can add, 
subtract, multiply, divide and use comparative operators to obtain desired result from data in the worksheet. 
A formula is used in worksheet when you want to draw some result from the entered data. Formula in 
LibreOffice Calc is always starts with (=) sign. Sign “=” shows that the data entered in the related cell is a 
formula. You can apply any type of formula as given below:  

=5+7+10  

=5(25-10)/100  

=A4+A5+A6+A7  

  

Functions  
In LibreOffice Calc these functions are pre-designed formulas which are used in the worksheet to operate on 
the stored data. In LibreOffice Calc pre-defined functions are divided in the following parts:   

• Database  

• Date & Time  

• Financial  

• Information  

• Logical  

• Mathematical  

• Array  

• Statistical  

• Spreadsheet  

• Text  

• Add-in  

  

Database Functions  
Database Functions deals with functions used with data organized as one row of data for one record.  

  

DAVERAGE  

FUNCTIONS 
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DAVERAGE returns the average of the values of all cells (fields) in all rows (database records) that match the 
specified search criteria.  

=DAVERAGE(Database; DatabaseField; SearchCriteria)  

=DAVERAGE(A1:E10;"Weight";A13:E14)  
  

DCOUNT  

DCOUNT counts the number of rows (records) in a database that match the specified search criteria and 
contain numerical values in the DatabaseField column.  

=DCOUNT(Database; [DatabaseField]; SearchCriteria)  

=DCOUNT(A1:E10;D1;A13:E14)  

  

DCOUNTA  

DCOUNTA counts the number of rows (records) in a database that match the specified search conditions, and 
contain numeric or alphanumeric values.  

=DCOUNTA(Database; [DatabaseField]; SearchCriteria)  

=DCOUNTA(A1:E10;"Name";  

  

DGET  

DGET returns the contents of the referenced cell in a database which matches the specified search criteria. In 
case of an error, the function returns either #VALUE! for no row found, or Err502 for more than one cell found.  

=DGET(Database; DatabaseField; SearchCriteria)  

=DGET(A1:E10;"Grade";A13:E14)  

  

DMAX  

DMAX returns the maximum content of a cell (field) in a database (all records) that matches the specified 
search conditions.  

=DMAX(Database; DatabaseField; SearchCriteria)  

=DMAX(A1:E10;"Weight";A13:E14)  

  

DMIN  

DMIN returns the minimum content of a cell (field) in a database that matches the specified search criteria.  

=DMIN(Database; DatabaseField; SearchCriteria)  

=DMIN(A1:E10;"Distance to School";A13:E14)  

  

DPRODUCT  

DPRODUCT multiplies all cells of a data range where the cell contents match the search criteria. 
=DPRODUCT(Database; DatabaseField; SearchCriteria)  

  

DSTDEV  

DSTDEV calculates the standard deviation of a population based on a sample, using the numbers in a database 
column that match the given conditions. The records are treated as a sample of data. That means that the 
children in the example represent a cross section of all children. Note that a representative result can not be 
obtained from a sample of less than one thousand.  
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=DSTDEV(Database; DatabaseField; SearchCriteria)  

=DSTDEV(A1:E10;"Weight";A13:E14)  

  

DSTDEVP  

DSTDEVP calculates the standard deviation of a population based on all cells of a data range which match the 
search criteria. The records from the example are treated as the whole population.  

=DSTDEVP(Database; DatabaseField; SearchCriteria)  

=DSTDEVP(A1:E10;"Weight";A13:E14)  

  

DSUM  

DSUM returns the total of all cells in a database field in all rows (records) that match the specified search 
criteria.  

=DSUM(Database; DatabaseField; SearchCriteria)  

=DSUM(A1:E10;"Distance to School";A13:E14)  

  

DVAR  

DVAR returns the variance of all cells of a database field in all records that match the specified search criteria. 
The records from the example are treated as a sample of data. A representative result cannot be obtained 
from a sample population of less than one thousand.  

=DVAR(Database; DatabaseField; SearchCriteria)  

=DVAR(A1:E10;"Weight";A13:E14)  

  

DVARP  

DVARP calculates the variance of all cell values in a database field in all records that match the specified search 
criteria. The records are from the example are treated as an entire population.  

=DVARP(Database; DatabaseField; SearchCriteria)  

=DVARP(A1:E10;"Weight";A13:E14)  

  

Date & Time Functions  
These spreadsheet functions are used for inserting and editing dates and times. LibreOffice internally handles 
a date/time value as a numerical value. If you assign the numbering format "Number" to a date or time value, 
it is converted to a number. For example, 01/01/2000 12:00 PM, converts to 36526.5. The value preceding the 
decimal point corresponds to the date; the value following the decimal point corresponds to the time. If you 
do not want to see this type of numerical date or time representation, change the number format (date or 
time) accordingly. To do this, select the cell containing the date or time value, call its context menu and select 
Format Cells. The Numbers tab page contains the functions for defining the number format.  

  

DATE  

This function calculates a date specified by year, month, day and displays it in the cell's formatting. The default 
format of a cell containing the DATE function is the date format, but you can format the cells with any other 
number format.  

=DATE(Year; Month; Day)  

=DATE(00;1;31)  
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If the values for month and day are out of bounds, they are carried over to the next digit. If you enter 
=DATE(00;12;31) the result will be 2000-12-31. If, on the other hand, you enter =DATE(00;13;31) the result 
will be 2001-01-31.  

TODAY  

Returns the current computer system date. The value is updated when you reopen the document or modify 
the values of the document. NOW is a function without arguments.  

=TODAY()  

  

YEAR  

Returns the year as a number according to the internal calculation rules.  

=YEAR(Number)  

=YEAR(1) returns 1899  

=YEAR(2) returns 1900  

=YEAR(33333.33)  returns 1991  

  

NOW  

Returns the computer system date and time. The value is updated when you recalculate the document or each 
time a cell value is modified. NOW is a function without arguments.  

=NOW()  

  

MINUTE  

Calculates the minute for an internal time value. The minute is returned as a number between 0 & 59.  

=MINUTE(Number)  

=MINUTE(8.999) returns 58  

=MINUTE(8.9999) returns 59  

  

MONTH  

Returns the month for the given date value. The month is returned as an integer between 1 and 12. 
=MONTH(Number)  

=MONTH(NOW())  returns the current month.  

  

DAY  

Returns the day of given date value. The day is returned as an integer between 1 and 31. You can also enter a 
negative date/time value.  

=DAY(Number)  

=DAY(1)  returns 31 (since LibreOffice starts counting at zero from December 30, 1899) =DAY(NOW()) returns 
the current day.  

  

DAYS  

Calculates the difference between two date values. The result returns the number of days between the two 
days.  

=DAYS(Date2; Date1)  

=DAYS(NOW();"2010-01-01")) returns the number of days from January 1, 2010 until today.  
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=DAYS ("1990-10-10";"1980-10-10") returns 3652 days.  

  

  

  

WEEKDAY  

Returns the day of the week for the given date value. The day is returned as an integer between 1 (Sunday) 
and 7 (Saturday) if no type or type=1 is specified. For other types, see the table below.  

=WEEKDAY(Number; Type)  

=WEEKDAY(NOW()) returns the number of the current day.  

=WEEKDAY("2000-06-14") returns 4  

=WEEKDAY("1996-07-24";2)  returns 3 (the Type parameter is 2, therefore Monday is day number 1. July 24, 
1996 was a Wednesday and therefore day number 3).  

  

TIME  

TIME returns the current time value from values for hours, minutes and seconds. This function can be used to 
convert a time based on these three elements to a decimal time value.  

=TIME(Hour; Minute; Second)  

=TIME(0;0;0) returns 00:00:00  

=TIME(4;20;4) returns 04:20:04  

  

TIMEVALUE  

TIMEVALUE returns the internal time number from a text enclosed by quotes and which may show a possible 
time entry format.  

=TIMEVALUE("Text")  

=TIMEVALUE("4PM") returns 0.67. When formatting in time format HH:MM:SS, you then get 16:00:00 
=TIMEVALUE("24:00") returns 0. If you use the HH:MM:SS time format, the value is 00:00:00.  

  

Financial Functions  
This category contains the mathematical finance functions of LibreOffice Calc.   

  

ACCRINT  

Calculates the accrued interest of a security in the case of periodic payments.  

=ACCRINT(Issue; FirstInterest; Settlement; Rate; Par; Frequency; Basis)  

  

Issue (required) is the issue date of the security.  

FirstInterest (required) is the first interest date of the security.  

Settlement (required) is the date at which the interest accrued up until then is to be calculated. Rate 

(required) is the annual nominal rate of interest (coupon interest rate) Par (optional) is the par value of 

the security.  

Frequency (required) is the number of interest payments per year (1, 2 or 4).  

Basis (optional) is chosen from a list of options and indicates how the year is to be calculated. Basic can be 0 
to 4  

0 or missing US method (NASD), 12 months of 30 days each  
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1 Exact number of days in months, exact number of days in year  

2 Exact number of days in month, year has 360 days  

3 Exact number of days in month, year has 365 days  

4 European method, 12 months of 30 days each  

  
Example:   =ACCRINTM("2001-04-01";"2001-06-15";0.1;1000;3) returns 20.54795.  

A security is issued on 2001-04-01. The maturity date is set for 2001-06-15. The Rate is 0.1 or 10% and Par is 
1000 currency units. The basis of the daily/annual calculation is the daily balance (3).   

  

AMORDEGRC  

Calculates the amount of depreciation for a settlement period as degressive amortization. Unlike AMORLINC, 
a depreciation coefficient that is independent of the depreciable life is used here.  

=AMORDEGRC(Cost; DatePurchased; FirstPeriod; Salvage; Period; Rate; Basis)  

  

Cost is the acquisition costs.  

DatePurchased is the date of acquisition.  

FirstPeriod is the end date of the first settlement period.  

Salvage is the salvage value of the capital asset at the end of the depreciable life.  

Period is the settlement period to be considered.  

Rate is the rate of depreciation.  

Basis (optional) is chosen from a list of options and indicates how the year is to be calculated.  

  

AMORLINC  

Calculates the amount of depreciation for a settlement period as linear amortization. If the capital asset is 
purchased during settlement period, the proportional amount of depreciation is considered.  

=AMORLINC(Cost; DatePurchased; FirstPeriod; Salvage; Period; Rate; Basis)  

  

DB  

Returns the depreciation of an asset for a specified period using the fixed-declining balance method. This form 
of depreciation is used if you want to get a higher depreciation value at the beginning of the depreciation (as 
opposed to linear depreciation). The depreciation value is reduced with every depreciation period by the 
depreciation already deducted from the initial cost.  

=DB(Cost; Salvage; Life; Period; Month)  

=DB(25000;1000;36;1;6) = 1,075.00 currency units  

Cost is the initial cost of an asset.  

Salvage is the value of an asset at the end of the depreciation.  

Life defines the period over which an asset is depreciated.  

Period is the length of each period. The length must be entered in the same date unit as the depreciation 
period.  

Month (optional) denotes the number of months for the first year of depreciation. If an entry is not defined, 
12 is used as the default.  

  

DDB  
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Returns the depreciation of an asset for a specified period using the arithmetic-declining method. Use this 
form of depreciation if you require a higher initial depreciation value as opposed to linear depreciation. The 
depreciation value gets less with each period and is usually used for assets whose value loss is higher shortly 
after purchase (for example, vehicles, and computers). Please note that the book value will never reach zero 
under this calculation type.  

=DDB(Cost; Salvage; Life; Period; Factor)    =DDB(75000;1;60;12;2) = 1,721.81 currency units.  
Cost fixes the initial cost of an asset.  

Salvage fixes the value of an asset at the end of its life.  

Life is the number of periods (for example, years or months) defining how long the asset is to be used. Period 
states the period for which the value is to be calculated.  

Factor (optional) is the factor by which depreciation decreases. If a value is not entered, the default is factor 
2.  

  

DISC  

Calculates the allowance (discount) of a security as a percentage.  

=DISC("Settlement"; "Maturity"; Price; Redemption; Basis)  

=DISC("2001-01-25";"2001-11-15";97;100;3)  returns about 0.0372 or 3.72 per cent.  

  

Settlement is the date of purchase of the security.  

Maturity is the date on which the security matures (expires).  

Price is the price of the security per 100 currency units of par value.  

Redemption is the redemption value of the security per 100 currency units of par value.  

Basis (optional) is chosen from a list of options and indicates how the year is to be calculated.  

  

IRR  

Calculates the internal rate of return for an investment. The values represent cash flow values at regular 
intervals, at least one value must be negative (payments), and at least one value must be positive (income). If 
the payments take place at irregular intervals, use the XIRR function. =IRR(Values; Guess)  

Values represents an array containing the values.  

Guess (optional) is the estimated value. An iterative method is used to calculate the internal rate of return. If 
you can provide only few values, you should provide an initial guess to enable the iteration.  

Example  

Under the assumption that cell contents are A1=-10000, A2=3500, A3=7600 and A4=1000, the formula 
=IRR(A1:A4) gives a result of 11,33%.  

  

ISPMT  

Calculates the level of interest for unchanged amortization installments.  

=ISPMT(Rate; Period; TotalPeriods; Invest)  

Rate sets the periodic interest rate.  

Period is the number of installments for calculation of interest.  

TotalPeriods is the total number of installment periods. Invest is the 
amount of the investment.  

Example  
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For a credit amount of 120,000 currency units with a two-year term and monthly installments, at a yearly 
interest rate of 12% the level of interest after 1.5 years is required.  

=ISPMT(1%;18;24;120000) = -300 currency units. The monthly interest after 1.5 years amounts to 300 currency 
units.  

PV  

Returns the present value of an investment resulting from a series of regular payments. Use this function to 
calculate the amount of money needed to be invested at a fixed rate today, to receive a specific amount, an 
annuity, over a specified number of periods. You can also determine how much money is to remain after the 
elapse of the period. Specify as well if the amount is to be paid out at the beginning or at the end of each 
period.  

Enter these values either as numbers, expressions or references. If, for example, interest is paid annually at 
8%, but you want to use month as your period, enter 8%/12 under Rate and LibreOffice Calc with automatically 
calculate the correct factor.  

= PV(Rate; NPer; Pmt; FV; Type)  

Rate defines the interest rate per period.  

NPer is the total number of periods (payment period).  

Pmt is the regular payment made per period.  

FV (optional) defines the future value remaining after the final installment has been made.  

Type (optional) denotes due date for payments. Type = 1 means due at the beginning of a period and Type = 
0 (default) means due at the end of the period.  

  

Example  

What is the present value of an investment, if 500 currency units are paid out monthly and the annual interest 
rate is 8%? The payment period is 48 months and 20,000 currency units are to remain at the end of the 
payment period.  

=PV(8%/12;48;500;20000) = -35,019.37 currency units.   

Under the named conditions, you must deposit 35,019.37 currency units today, if you want to receive 500 
currency units per month for 48 months and have 20,000 currency units left over at the end. Cross-checking 
shows that 48 x 500 currency units + 20,000 currency units = 44,000 currency units. The difference between 
this amount and the 35,000 currency units deposited represents the interest paid.  

  

Information Functions  
Information Functions contains the Information functions.  

  

CELL  

Returns information on address, formatting or contents of a cell.  

= CELL("InfoType"; Reference)  

=CELL("COL";D2)   

=CELL("ROW";D2)   

=CELL("Sheet";Sheet3.D2)  

InfoType is the character string that specifies the type of information. The character string is always in English. 
Upper or lower case is optional.  
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CURRENT  

This function returns the result to date of evaluating the formula of which it is a part (in other words the result 
as far as that evaluation has got). Its main use is together with the STYLE() function to apply selected styles to 
a cell depending on the cell contents.  

= CURRENT()  

=1+2+CURRENT()  

=A2+B2+STYLE(IF(CURRENT()>10;”Red”;”Default”))  

The example returns 6. The formula is calculated from left to right as: 1 + 2 equals 3, giving the result to date 
when CURRENT() is encountered; CURRENT() therefore yields 3, which is added to the original 3 to give 6.  

  

IFERROR  

Returns the value if the cell does not contains an error value, or the alternative value if it does.  

=IFERROR(Value;Alternate_value)  

=IFERROR(C8;C9) where cell C8 contains =1/0 returns the value of C9, because 1/0 is an error Value is the 
value or expression to be returned if it is not equal or results in an error.  

Alternate_value is the value or expression to be returned if the expression or value of Value is equal or results 
in an error.  

  

INFO  

Returns specific information about the current working environment. The function receives a single text 
argument and returns data depending on that parameter.  

=INFO("Type")  

=INFO(D5) with cell D5 containing a text string system returns the operation system type.  

The following table lists the values for the text parameter Type and the return values of the INFO function.  

  

ISBLANK  

Returns TRUE if the reference to a cell is blank. This function is used to determine if the content of a cell is 
empty. A cell with a formula inside is not empty. If an error occurs, the function returns a logical or numerical 
value.  

= ISBLANK(Value)  

=ISBLANK(D2) returns FALSE as a result.  

Value is the content to be tested.  

  

ISERR  

Tests for error conditions, except the #N/A error value, and returns TRUE or FALSE. If an error occurs, the 
function returns a logical or numerical value.  

= ISERR(Value)  

=ISERR(C8) where cell C8 contains =1/0 returns TRUE, because 1/0 is an error.  

=ISERR(C9) where cell C9 contains =NA() returns FALSE, because ISERR() ignores the #N/A error. Value is any 
value or expression which is tested to see whether an error value other than #N/A is present.  

  

ISERROR  
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Tests for error conditions, including the #N/A error value, and returns TRUE or FALSE. If an error occurs, the 
function returns a logical or numerical value.  

= ISERROR(Value)  

=ISERROR(C8) where cell C8 contains =1/0 returns TRUE, because 1/0 is an error.  

=ISERROR(C9) where cell C9 contains =NA() returns TRUE.  

ISEVEN  

Value is or refers to the value to be tested. ISERROR() returns TRUE if there is an error and FALSE if not.  

  

ISLOGICAL  

Tests for a logical value (TRUE or FALSE). If an error occurs, the function returns FALSE.  

= ISLOGICAL(Value)  

=ISLOGICAL(99) returns FALSE, because 99 is a number, not a logical value.  

=ISLOGICAL(ISNA(D4)) returns TRUE whatever the contents of cell D4, because ISNA() returns a logical value.  

  

ISODD  

Returns TRUE if the value is odd, or FALSE if the number is even.  

= ISODD(value)  

=ISODD(33) returns TRUE  

=ISODD(48) returns FALSE  

=ISODD(3.999) returns TRUE  

=ISODD(-3.1) returns TRUE  

Value is the value to be checked. If Value is not an integer any digits after the decimal point are ignored. The 
sign of Value is also ignored.  

  

Logical Functions  
This category contains the Logical functions.   

Handling non-logical arguments in logical functions  

• Zero (0) is equivalent to FALSE and all other numbers are equivalent to TRUE.  

• Empty cells and text in cells are ignored.  

• A #VALUE error is raised if all arguments are ignored.  

• A #VALUE error is raised if one argument is direct text (not text in a cell).  

• Errors as argument lead to an error.  

  

AND  

Returns TRUE if all arguments are TRUE. If one of the elements is FALSE, this function returns the FALSE value. 
The arguments are either logical expressions themselves (TRUE, 1<5, 2+3=7, B8<10) that return logical values, 
or arrays (A1:C3) containing logical values.  

= AND(LogicalValue1; LogicalValue2 ...LogicalValue30)  
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LogicalValue1; LogicalValue2 ...LogicalValue30 are conditions to be checked. All conditions can be either TRUE 
or FALSE. If a range is entered as a parameter, the function uses all values of the range. The result is TRUE if 
the logical value in all cells within the cell range is TRUE.  

Example  

The logical values of entries 12<13; 14>12, and 7<6 are to be checked:  

=AND(12<13;14>12;7<6) returns FALSE.  

=AND (FALSE;TRUE) returns FALSE.  

  

FALSE  

Returns the logical value FALSE. The FALSE() function does not require any arguments, and always returns the 
logical value FALSE.  

=FALSE()  

=FALSE() returns FALSE  

=NOT(FALSE()) returns TRUE  

  

IF  

Specifies a logical test to be performed.  

= IF(Test; ThenValue; OtherwiseValue)  

=IF(A1>5;100;"too small")   

If the value in A1 is higher than 5, the value 100 is entered in the current cell; otherwise, the text “too small” 
(without quotes) is entered.  

Test is any value or expression that can be TRUE or FALSE.  

ThenValue (optional) is the value that is returned if the logical test is TRUE.  

OtherwiseValue (optional) is the value that is returned if the logical test is FALSE.  

  

NOT  

Complements (inverts) a logical value.  

= NOT(LogicalValue)  

=NOT(A). If A=TRUE then NOT(A) will evaluate FALSE.  

LogicalValue is any value to be complemented.  

  

OR  

Returns TRUE if at least one argument is TRUE. This function returns the value FALSE, if all the arguments have 
the logical value FALSE.  

The arguments are either logical expressions themselves (TRUE, 1<5, 2+3=7, B8<10) that return logical values, 
or arrays (A1:C3) containing logical values. = OR(LogicalValue1; LogicalValue2 ...LogicalValue30)  

  

Example  

The logical values of entries 12<11; 13>22, and 45=45 are to be checked.  

=OR(12<11;13>22;45=45) returns TRUE. =OR(FALSE;TRUE) returns 
TRUE.  
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TRUE  

The logical value is set to TRUE. The TRUE() function does not require any arguments, and always returns the 
logical value TRUE.  

= TRUE()  

  

Example  

If A=TRUE and B=FALSE the following examples appear:  

=AND(A;B) returns FALSE  

=OR(A;B) returns TRUE  

=NOT(AND(A;B)) returns TRUE  

  

XOR  

Returns true if an odd number of arguments evaluates to TRUE.  

The arguments are either logical expressions themselves (TRUE, 1<5, 2+3=7, B8<10) that return logical values, 
or arrays (A1:C3) containing logical values.  

= XOR(LogicalValue1; LogicalValue2 ...LogicalValue30)  

Example  

=XOR(TRUE;TRUE) returns FALSE  

=XOR(TRUE;TRUE;TRUE) returns TRUE  

=XOR(FALSE;TRUE) returns TRUE  

  

Mathematical Functions  
This category contains the Mathematical functions for Calc.  

  

ABS  

Returns the absolute value of a number.  

= ABS(Number) =ABS(-56) returns 56.  

=ABS(12) returns 12. =ABS(0) returns 
0.  

Number is the number whose absolute value is to be calculated. The absolute value of a number is its value 
without the +/- sign.  

  

ACOS  

Returns the inverse trigonometric cosine of a number.  

=  ACOS(Number)  

=ACOS(-1) returns 3.14159265358979 (PI radians)  

=DEGREES(ACOS(0.5)) returns 60. The cosine of 60 degrees is 0.5.  

This function returns the inverse trigonometric cosine of Number, that is the angle (in radians) whose cosine 
is Number. The angle returned is between 0 and PI.  To return the angle in degrees, use the DEGREES function.  
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ACOSH  

Returns the inverse hyperbolic cosine of a number.  

= ACOSH(Number)  

=ACOSH(1) returns 0.  

=ACOSH(COSH(4)) returns 4.  

This function returns the inverse hyperbolic cosine of Number, that is the number whose hyperbolic cosine is 
Number. Number must be greater than or equal to 1.  

  

CEILING  

Rounds a number up to the nearest multiple of Significance.  

= CEILING(Number; Significance; Mode)  

=CEILING(-11;-2) returns -10  

=CEILING(-11;-2;0) returns -10  

=CEILING(-11;-2;1) returns -12  

Number is the number that is to be rounded up.  

Significance is the number to whose multiple the value is to be rounded up.  

Mode is an optional value. If the Mode value is given and not equal to zero, and if Number and Significance 
are negative, then rounding is done based on the absolute value of Number, i.e. negative numbers are rounded 
away from zero. If the Mode value is equal to zero or is not given, negative numbers are rounded towards 
zero.  

  

COMBIN  

Returns the number of combinations for elements without repetition. = 

COMBIN(Count1; Count2) =COMBIN(3;2) returns 3.  

Count1 is the number of items in the set.  

Count2 is the number of items to choose from the set.  

COMBIN returns the number of ordered ways to choose these items. For example if there are 3 items A, B and 
C in a set, you can choose 2 items in 3 different ways, namely AB, AC and BC. COMBIN implements the formula: 
Count1!/(Count2!*(Count1-Count2)!)  

  

COS  

Returns the cosine of the given angle (in radians).  

= COS(Number)  

=COS(PI()*2) returns 1, the cosine of 2*PI radians.  

=COS(RADIANS(60)) returns 0.5, the cosine of 60 degrees.  

Returns the (trigonometric) cosine of Number, the angle in radians. To return 

the cosine of an angle in degrees, use the RADIANS function.  

  

COT  

Returns the cotangent of the given angle (in radians).  

=COT(Number)  
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=COT(PI()/4) returns 1, the cotangent of PI/4 radians.  

=COT(RADIANS(45)) returns 1, the cotangent of 45 degrees.  

Returns the (trigonometric) cotangent of Number, the angle in radians. To return 

the cotangent of an angle in degrees, use the RADIANS function.  

The cotangent of an angle is equivalent to 1 divided by the tangent of that angle.  

  

CSC  

Returns the cosecant of the given angle (in radians). The cosecant of an angle is equivalent to 1 divided by the 
sine of that angle  

= CSC(Number)  

=CSC(PI()/4) returns approximately 1.4142135624, the inverse of the sine of PI/4 radians.  

=CSC(RADIANS(30)) returns 2, the cosecant of 30 degrees.  

  

DEGREES  

Converts radians into degrees.  

= DEGREES(Number)  

=DEGREES(PI()) returns 180 degrees.  

Number is the angle in radians to be converted to degrees.  

  

EVEN  

Rounds a positive number up to the next even integer and a negative number down to the next even integer.  

=EVEN(Number) =EVEN(2.3) returns 
4.  

=EVEN(2) returns 2.  

=EVEN(0) returns 0.  

=EVEN(-0.5) returns -2.  

Returns Number rounded to the next even integer up, away from zero.  

  

EXP  

Returns e raised to the power of a number. The constant e has a value of approximately 2.71828182845904.  

= EXP(Number)  

=EXP(1) returns 2.71828182845904, the mathematical constant e to Calc's accuracy. Number is the 
power to which e is to be raised.  

  

FACT  

Returns the factorial of a number.  

= FACT(Number)  

=FACT(0) returns 1 by definition.  

=FACT(3) returns 6.  

=FACT(0) returns 1.  

Returns Number!, the factorial of Number, calculated as 1*2*3*4* ... * Number.  
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FLOOR  

Rounds a number down to the nearest multiple of Significance.  

= FLOOR(Number; Significance; Mode)  

  

Number is the number that is to be rounded down.  

Significance is the value to whose multiple the number is to be rounded down. Mode is an 
optional value.  

  

GCD  

Returns the greatest common divisor of two or more integers. The greatest common divisor is the positive 
largest integer which will divide, without remainder, each of the given integers.  

= GCD(Integer1; Integer2; ...; Integer30)  

=GCD(B1:B3) where cells B1, B2, B3 contain 9, 12, 9 gives 3.  

Integer1 To 30 are up to 30 integers whose greatest common divisor is to be calculated.  

  

INT  

Rounds a number down to the nearest integer.  

= INT(Number) =INT(5.7) returns 
5.  

=INT(-1.3) returns -2.  

Returns Number rounded down to the nearest integer. Negative 

numbers round down to the integer below.  

  

LCM  

Returns the least common multiple of one or more integers.  

= LCM(Integer1; Integer2; ...; Integer30)  

Integer1 to 30 are up to 30 integers whose lowest common multiple is to be calculated.  

If you enter the numbers 512;1024 and 2000 in the Integer 1;2 and 3 text boxes, 128000 will be returned as 
the result.  

  

LN  

Returns the natural logarithm based on the constant e of a number. The constant e has a value of 
approximately 2.71828182845904.  

= LN(Number)  

=LN(3) returns the natural logarithm of 3 (approximately 1.0986). =LN(EXP(321)) returns 
321.  

Number is the value whose natural logarithm is to be calculated.  

  

LOG  

Returns the logarithm of a number to the specified base.  

= LOG(Number; Base)  
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=LOG(10;3) returns the logarithm to base 3 of 10 (approximately 2.0959). =LOG(7^4;7) returns 
4.  
MOD  

Returns the remainder when one integer is divided by another.  

= MOD(Dividend; Divisor)  

=MOD(22;3) returns 1, the remainder when 22 is divided by 3. =MOD(11.25;2.5) returns 
1.25.  

For integer arguments this function returns Dividend modulo Divisor, that is the remainder when Dividend is 
divided by Divisor.  

  

ODD  

Rounds a positive number up to the nearest odd integer and a negative number down to the nearest odd 
integer.  

= ODD(Number) =ODD(1.2) returns 
3.  

=ODD(1) returns 1.  

=ODD(0) returns 1.  

=ODD(-3.1) returns -5.  

Returns Number rounded to the next odd integer up, away from zero.  

  

PI  

Returns 3.14159265358979, the value of the mathematical constant PI to 14 decimal places.  

=  PI()  

=PI() returns 3.14159265358979.  

  

POWER  

Returns a number raised to another number.  

= POWER(Base; Exponent)  

=POWER(4;3) returns 64, which is 4 to the power of 3.  

=4^3 also returns 4 to the power of 3.  

  

Returns Base raised to the power of Exponent.  

The same result may be achieved by using the exponentiation operator ^:  

Base^Exponent  

  

PRODUCT  

Multiplies all the numbers given as arguments and returns the product. =  

PRODUCT(Number1; Number2; ...; Number30) =PRODUCT(2;3;4) returns 24.  

  

RADIANS  

Converts degrees to radians.  

= RADIANS(Number)  
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=RADIANS(90) returns 1.5707963267949, which is PI/2 to Calc's accuracy. Number is the 
angle in degrees to be converted to radians.  

RAND  

Returns a random number between 0 and 1.  

= RAND()  

=RAND() returns a random number between 0 and 1.  

This function produces a new random number each time Calc recalculates. To force Calc to recalculate 
manually press F9.  

  

ROUND  

Rounds a number to a certain number of decimal places.  

=ROUND(Number; Count) =ROUND(2.348;2) returns 

2.35 =ROUND(2.348;0) returns 2.  

=ROUND(2.5) returns 3.  

=ROUND(987.65;-2) returns 1000.  

Returns Number rounded to Count decimal places. If Count is omitted or zero, the function rounds to the 

nearest integer. If Count is negative, the function rounds to the nearest 10, 100, 1000, etc. This function 

rounds to the nearest number. See ROUNDDOWN and ROUNDUP for alternatives.  

  

SEC  

Returns the secant of the given angle (in radians). The secant of an angle is equivalent to 1 divided by the 
cosine of that angle  

= SEC(Number)  

=SEC(PI()/4) returns approximately 1.4142135624, the inverse of the cosine of PI/4 radians. 
=SEC(RADIANS(60)) returns 2, the secant of 60 degrees.  

Returns the (trigonometric) secant of Number, the angle in radians. To return 

the secant of an angle in degrees, use the RADIANS function.  

  

SIGN  

Returns the sign of a number. Returns 1 if the number is positive, -1 if negative and 0 if zero.  

= SIGN(Number) =SIGN(3.4) returns 
1.  

=SIGN(-4.5) returns -1.  

Number is the number whose sign is to be determined.  

  

SIN  

Returns the sine of the given angle (in radians).  

= SIN(Number)  

=SIN(PI()/2) returns 1, the sine of PI/2 radians.  

=SIN(RADIANS(30)) returns 0.5, the sine of 30 degrees.  

Returns the (trigonometric) sine of Number, the angle in radians.  
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To return the sine of an angle in degrees, use the RADIANS function.  

  
SQRT  

Returns the positive square root of a number.  

= SQRT(Number)  

=SQRT(16) returns 4.  

=SQRT(-16) returns an invalid argument error  

Returns the positive square root of Number. Number must be positive.  

  

SUBTOTAL  

Calculates subtotals. If a range already contains subtotals, these are not used for further calculations. Use this 
function with the AutoFilters to take only the filtered records into account.  

= SUBTOTAL(Function; Range) =SUBTOTAL(9;B2:B6) returns 
50.  

=SUBTOTAL(109;B2:B6) returns 40.  

  

SUM  

Adds all the numbers in a range of cells.  

= SUM(Number1; Number2; ...; Number30)  

=SUM(A1;A3;B5) calculates the sum of the three cells.   

=SUM (A1:E10) calculates the sum of all cells in A1 to E10 cell range.  

=SUM((A1:A40>=C1)*(A1:A40<C2)*B1:B40)  

  

SUMIF  

Adds the cells specified by a given criteria. This function is used to browse a range when you search for a 
certain value.  

= SUMIF(Range; Criteria; SumRange)  

=SUMIF(A1:A10;"<0")  

=SUMIF(A1:A10;">0";B1:10)  

Range is the range to which the criteria are to be applied.  

Criteria is the cell in which the search criterion is shown, or the search criterion itself. If the criteria is written 
into the formula, it has to be surrounded by double quotes.  

SumRange is the range from which values are summed. If this parameter has not been indicated, the values 
found in the Range are summed.  

  

Text Functions  
Text Functions contains descriptions of the Text functions.   

  

CHAR  
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Converts a number into a character according to the current code table. The number can be a twodigit or 
three-digit integer number. Codes greater than 127 may depend on your system's character mapping (for 
example iso-8859-1, iso-8859-2, Windows-1252, Windows-1250), and hence may not be portable.  

= CHAR(Number)  
=CHAR(100) returns the character d.  

Number is a number between 1 and 255 representing the code value for the character.  

  

CLEAN  

All non-printing characters are removed from the string.  

=CLEAN("Text")  

Text refers to the text from which to remove all non-printable characters.  

  

CONCATENATE  

Combines several text strings into one string.  

= CONCATENATE("Text1"; ...; "Text30")  

=CONCATENATE("Good ";"Morning ";"Mrs. ";"Doe") returns: Good Morning Mrs. Doe.  

  

Text 1; Text 2; ... represent up to 30 text passages which are to be combined into one string.  

  

EXACT  

Compares two text strings and returns TRUE if they are identical. This function is case-sensitive.  

= EXACT("Text1"; "Text2")  

=EXACT("microsystems";"Microsystems") returns FALSE.  

Text1 refers to the first text to compare. Text2 is the 
second text to compare.  

  

LEFT  

Returns the first character or characters of a text.  

= LEFT("Text"; Number)  

=LEFT("output";3) returns “out”.  

Text is the text where the initial partial words are to be determined.  

Number (optional) specifies the number of characters for the start text. If this parameter is not defined, one 
character is returned.  

  

LEN  

Returns the length of a string including spaces.  

= LEN("Text")  

=LEN("Good Afternoon") returns 14.  

=LEN(12345.67) returns 8.  

Text is the text whose length is to be determined.  

  

LOWER  
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Converts all uppercase letters in a text string to lowercase.  

= LOWER("Text")  

=LOWER("Sun") returns sun.  

Text refers to the text to be converted.  

  

  
PROPER  

Capitalizes the first letter in all words of a text string.  

= PROPER("Text")  

=PROPER("open office") returns Open Office.  

Text refers to the text to be converted.  

  

REPT  

Repeats a character string by the given number of copies.  

=  REPT("Text"; Number)  

=REPT("Good morning";2) returns Good morningGood morning.  

Text is the text to be repeated. Number is the 

number of repetitions.  

The result can be a maximum of 255 characters.  

  

TRIM  

Removes spaces from a string, leaving only a single space character between words.  

= TRIM("Text")  

=TRIM(" hello world ") returns hello world without leading and trailing spaces and with single space between 
words.  

Text refers to text in which spaces are to be removed.  

  

UNICHAR  

Converts a code number into a Unicode character or letter.  

= UNICHAR(number)  

=UNICHAR(169) returns the Copyright character ©.  

  

UNICODE  

Returns the numeric code for the first Unicode character in a text string.  

= UNICODE("Text")  

=UNICODE("©") returns the Unicode number 169 for the Copyright character.  

  

UPPER  

Converts the string specified in the text field to uppercase.  

= UPPER("Text") Text refers to the lower case letters you want to convert to upper case.  

=UPPER("Good Morning") returns GOOD MORNING.  
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VALUE  

Converts a text string into a number.  

= VALUE("Text")  

=VALUE("4321") returns 4321.  

Text is the text to be converted to a number.  

  
  

 

  

  

  

LibreOffice Impress lets you create professional slide shows that can include charts, drawing objects, text, 
multimedia and a variety of other items. If you want, you can even import and modify Microsoft PowerPoint 
presentations.  

For on-screen slide shows, animation, slide transitions and multimedia are a few of the techniques you can 
use to make your presentation more exciting.  

  

Creating Vector Graphics  

Many of the tools for creating vector graphics in LibreOffice Draw are available in LibreOffice Impress.  

  

Creating Slides  

LibreOffice Impress provides you with templates to create professional-looking slides. You can also assign a 
number of dynamic effects to your slides, including animation and transition effects.  

  

Creating Presentations  

Several views or pages are available when you design a slide show. For example, the Slide Sorter displays an 
overview of your slides in thumbnail form, while the Handout page contains both the slide and the text you 
want to distribute to the audience. LibreOffice Impress also lets you rehearse the timing of your slide show.  

  

Publishing Presentations  

You can publish your slides on-screen, as handouts, or as HTML documents.  

  

Giving Presentations  

LibreOffice Impress gives you the choice of running a slide show automatically or manually.  

  

Creating Web Presentation  

Web presentation can be easily prepared in Impress Presentation. It can be accessed easily by using any web 
browser. To use Power Point, it is necessary to start it. When you start Presentation then a new presentation 
(Untitled 1) creates on its own. After saving it, the given file name will be displayed here.   

Lesson - 4:  Impress 
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Interface- Impress  
LibreOffice Impress interface is look like a Microsoft PowerPoint.  Maximum menu, toolbars and commands 
are managed according to Microsoft PowerPoint. Command icons are also displays and arranged at toolbars.  
If you are familiar with Microsoft PowerPoint, you can easily operate and work in LibreOffice Impress.  

 
  

The top line of LibreOffice Impress window is called Title Bar. Name of the file, program name related 

information is displayed in the title bar. You can see slides in big or small view with the help of zoom slider. 

The zoom size of slide in LibreOffice Impress is 72% by default. You can make it up to minimum 5% and 

maximum 3000%.   

LibreOffice Impress includes several tools to help organize and arrange content on your slides, including the 
Ruler, guides, and gridlines. These tools make it easier to align objects on your slides. Simply click the check 
boxes in the Show group on the View tab to show and hide these tools.  

Ruler bar is displayed right below the ribbon bar. It displays that functional field, where we do typing of slide. 
In LibreOffice Impress, you can “ON” or “OFF” ruler bar with the help of Ruler command in View menu or using 
shortcut key (Ctrl+Shift+R). Status bar is displayed at the bottom in Microsoft Power Point windows, which 
displays the current position of the slide or presentation like – slide number title, slide number, column 
number, views button, zoom level etc.   

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

Title Bar   

Zoom Level   
Horizontal Scroll Bar   

Properties Toolbar   

Vertical Scroll Bar  

Control Menu   
Menu   Bar   Standard Toolbar   Drawing Toolbar   

Status Bar   

Slide Outline  
Pane   

Slide Pane   
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You can also uses the properties bar for making and modify a slide. The properties bar will be changed as per 
your selection of text, object, text box, chart, etc.  Your work on a slide is display on the slide pane. You can 
use F5 key to start a slide show.  

Menus  
The window containing the document you want to work on must be selected in order to use the menu 
commands. Similarly, you must select an object in the document to use the menu commands associated with 
the object. The following section lists the help topics available for menus and dialogs.  

  

File  

These commands apply to the current document, open a new document, or close the application.  

  

Edit  

This menu contains commands for editing the contents of the current document.  

  

View  

This menu contains commands for controlling the on-screen display of the document.  

  

Insert  

This menu contains the commands that are used to insert new elements into the document, for example, 
graphics, objects, special characters and other files.  

  

Format  

Contains commands for formatting the layout and the contents of your document.  

  

Slide  

This menu provides slide management and navigation commands.  

  

Slide Show  

Contains commands and options for running a presentation.  

  

Tools  

Contains spelling tools, a gallery of object art that you can add to your document, as well as tools for 
configuring menus, and setting program preferences.  

  

Window  

Contains commands for manipulating and displaying document windows.  

  

Help  

The Help menu allows you to start and control the LibreOffice Help system.  

  

FILE MENU  
These commands apply to the current document, open a new document, or close the application.  
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New  

Creates a new LibreOffice document. You can use shortcut key (Ctrl+N) for this command.  

  

  
Open  

Opens a local or remote file, or imports one. You can use shortcut key 
(Ctrl+O) for this command.  

  

Close  

Closes the current document without exiting the program.  

  

Wizards  

Guides you through creating business and personal letters, faxes, 
agendas, presentations, and more.  

  

Templates  

Lets you organize and edit your templates, as well as save the current file as 
a template.  

  

Versions  

Saves and organizes multiple versions of the current document in the same 
file. You can also open, delete and compare previous versions.  

  

Save  

Saves the current document. You can use shortcut key (Ctrl+S) for this 
command. You can use the Save As command to Saves the current 
document in a different location, or with a different file name or file type. 
You can use shortcut key (Ctrl+Shift+S) for this command.  

  

Export as PDF  

Saves the current file to Portable Document Format (PDF) version 1.4.  

A PDF file can be viewed and printed on any platform with the original formatting intact, provided that 
supporting software is installed.  

  

Preview in Web Browser  

Creates a temporary copy of the current document in HTML format, opens the system default Web browser, 
and displays the HTML file in the Web browser.  

  

Print  

Prints the current document, selection, or the pages that you specify. You can also set the print options for 
the current document. The printing options can vary according to the printer and the operating system that 
you use. You can use shortcut key (Ctrl+P) for this command. select the Printer Settings command to Select 
the default printer for the current document.  
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Document Properties  

Displays the properties for the current file, including statistics such as word count and the date the file was 
created.  

  

EDIT MENU  
This menu contains commands for editing the contents of the 
current document.  

  

Undo  

Reverses the last command or the last entry you typed. To select 
the command that you want to reverse, click the arrow next 
to the Undo icon on the Standard bar. You can use shortcut key 
(Ctrl+Z) for this command.  

  

Redo  

Reverses the action of the last Undo command. To select the 
Undo step that you want to reverse, click the arrow next to the 
Redo icon on the Standard bar. You can use shortcut key 
(Ctrl+Y) for this command.  

  

Cut, Copy and Paste  

Cut command is used to removes and copies the selection to the 
clipboard and Copy command is used to Copies the 
selection to the clipboard. Paste command Inserts the 
contents of the clipboard at the location of the cursor, and 
replaces any selected text or objects. You can use shortcut key (Ctrl+C) for copy command, Ctrl+X for cut 
command and Ctrl+V for this command.  

  

Select All  

Selects the entire content of the current file, frame, or text object. You can use shortcut key (Ctrl+A) for this 
command.  

  

Find & Replace  

Finds or replaces text or formats in the current document. You can use shortcut key (Ctrl+H) for this command.  

  

Duplicate  

Makes one or more copies of a selected object.  

  

Points  

Switches the Edit Points mode on and off.  

  

Glue Points  

Switches the Edit Glue Points mode on and off.  

  

Hyperlink  
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Opens a dialog that enables you to create and edit hyperlinks.  

  
Fields  

Edits the properties of an inserted field.  

  

Delete Slide  

Deletes the current slide or page.  

  

Links  

Lets you edit the properties of each link in the current document, including the path to the source file. This 
command is not available if the current document does not contain links to other files.  

  

ImageMap  

Allows you to attach URLs to specific areas, called hotspots, on a graphic or a group of graphics. An image map 
is a group of one or more hotspots.  

  

Object  

Lets you edit a selected object in your file that you inserted with the Insert - Object command.  

  

VIEW MENU  
This menu contains commands for controlling the on-screen display of the document.  

  

Normal  

Switches to normal view, where you can create and edit your slides.  

  

Outline  

Switches to outline view, where you can add, edit and reorganize slide titles and headings.  

  

Notes  

Switches to notes view, where you can add notes to your slides. Notes are hidden from the audience when 
you give your presentation.  

  

Handout  
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Switches to the handout page view, where you c an scale several slides to fit on 
one printed page.  

  

Slide Sorter  

Displays miniature versions of the slides so they can easily be rearranged.  

  

Master Slide  

Switches to master slide view, where you can add elements that you want to 
appear on all of the slides that use the same master slide.  

  

Master Notes  

Displays the master notes, where you can set the default formatting for 
notes.  
Toolbars  

Opens a submenu to show and hide toolbars. A toolbar contains icons and 
options that let you quickly access LibreOffice commands. You can use Status 
Bar command to Shows or hides the Status bar at the bottom edge of the 
window and Rulers command to displays or hides rulers at the top and left or 
right edges of the workspace.  

  

Slide Pane  

Switches the Slide Pane on and off.  

  

Grid  

Sets the display properties of a grid.  

  

Snap Lines  

Specifies the display options for snap lines.  

  

Object Moving Helplines  

Specifies whether to display guides when moving an object.  

  

Color/Grayscale  

Shows slides in color, grayscale, or black and white.  

  

Master Background  

Toggle the visibility of a master slide's background to be used as the background of the current slide.  

  

Master Objects  

Toggle the visibility of a master slide's objects to appear on the current slide.  

  

Master Elements  

Add header, footer, date, and slide number placeholders to the master slide.  
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Sidebar  

The Sidebar is a vertical graphical user interface that primarily provides contextual properties, style 
management, document navigation, and media gallery features.  

  

Styles  

Opens the Styles deck of the Sidebar, which lists the available graphic and presentation styles for applying and 
editing.  

  

Clip Art Gallery  

Opens the Gallery deck of the Sidebar, where you can select images and audio clips to insert into your 
document.  

  

Navigator  

Opens the Navigator, where you can quickly jump to other slides or move between open files.  

INSERT MENU  
This menu contains the commands that are used to insert new elements into the document, for example, 
graphics, objects, special characters and other files.  

  

Slide Number  

Adds the slide number or the page number.   

  

Fields  

Lists common fields that you can insert into your slide.  

  

Comment  

Inserts a comment around the selected text or at the current cursor 
position.  

  

Special Character  

Allows a user to insert characters from the range of symbols found in the 
installed fonts.  

  

Formatting Mark  

Opens a submenu to insert special formatting marks like non-breaking 
space, soft hyphen, and optional break.  

  

Animated Image  

Creates a custom animation on the current slide. You can only use existing 
objects to create an animation.  

  

Media  

The submenu presents various sources that an image, audio or video can be insert from. You can Inserts a 
video or audio file into your document.  
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Object  

Inserts an embedded object into your document, including formulas, 3D models, charts and OLE objects.  

  

Floating Frame  

Inserts a floating frame into the current document. Floating frames are used in HTML documents to display 
the contents of another file.  

  

File  

Inserts a file into the active slide. You can insert LibreOffice Draw or Impress files, or text from an HTML 
document or a text file.  

  

Header and Footer  

Adds or changes text in placeholders at the top and the bottom of slides and master slides.  

FORMAT MENU  
Contains commands for formatting the layout and the contents of your document.  

  

Clear Direct Formatting  

Removes direct formatting and formatting by character styles from the selection. You can use shortcut key 
(Ctrl+Shift+M) for this command.  

  

Character  

Changes the font and the font formatting for the selected characters. Similarly, you can use Paragraph 
command to Modifies the format of the current paragraph, such as indents and alignment.  

  

Bullets and Numbering  

Adds numbering or bullets to the current paragraph, and lets you edit format of the numbering or bullets.  

  

Page  

Sets page orientation, page margins, background and other layout options.  

  

Change Case  
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Changes the case of characters in the selection. If the cursor is within a 
word and no text is selected, then the word is the selection.  

  

Position and Size  

Resizes, moves, rotates, or slants the selected object.  

  

Line  

Sets the formatting options for the selected line.  

  

Area  

Sets the fill properties of the selected drawing object.  

  

Text  

Sets the layout and anchoring properties for text in the selected 
drawing or text object.  

  

Slide Design  

Displays the Slide Design dialog, where you can select a layout 
scheme for the current slide. Any objects in the slide design are 
inserted behind objects in the current slide.  

  

Slide Layout  

Opens a submenu with slide layouts.  

  

Group  

Groups keep together selected objects, so that they can be moved or formatted as a single object.  

SLIDE SHOW MENU  
Contains commands and options for running a presentation.  

  

Start From First Slide   

This command is used for starts your slide show from first slide. You can 
use F5 key for this command.  

  

Start From Current Slide   

This command is used for starts your slide show from current slide. You 
can use shortcut key (Shift+ F5) or this command.  

  

Rehearse Timings  

Starts a slide show with a timer in the lower left corner.  

  

Custom Slide Show  

Defines a custom slide show using slides within the current presentation. You can then pick slides to meet the 
needs of your audience. You can create as many custom slide shows as you want.  
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Slide Show Settings  

Defines settings for your slide show, including which slide to start from, the way you advance the slides, the 
type of presentation, and pointer options.  

  

TOOLS MENU  
Contains spelling tools, a gallery of object art that you can add to your document, as well as tools for 
configuring menus, and setting program preferences.  

  

Spellcheck  

Checks spelling manually. You can use shortcut key (F7) for this 
command.  

  

Language  

Opens a submenu where you can choose language specific 
commands.  

  

Gallery  

Opens the Gallery deck of the Sidebar, where you can select 
images and audio clips to insert into your document.  

  

Color Replacer  

Opens the Color Replacer dialog, where you can replace colors in 
bitmap and meta file graphics.  

  

  

  
Media Player  

Opens the Media Player window where you can preview movie and sound files as well as insert these files into 
the current document.  

  

Macros  

Lets you record or organize and edit macros.  

  

Extension Manager  

The Extension Manager adds, removes, disables, enables, and updates LibreOffice extensions. You can use 
shortcut key (Ctrl+Alt+E) for this command.  

  

XML Filter Settings  

Opens the XML Filter Settings dialog, where you can create, edit, delete, and test filters to import and to export 
XML files.  

  

AutoCorrect Options  

Sets the options for automatically replacing text as you type.  
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Customize  

Customizes LibreOffice menus, context menus, shortcut keys, toolbars, and macro assignments to events.  

  

Options  

This command opens a dialog for a customized program configuration. You can use shortcut key (Alt+F12) for 
this command.  

  

  

Shortcut Keys for LibreOffice- Writer 

  

Shortcut keys  Effect  Shortcut keys  Effect  

F2  Formula Bar  Ctrl+0 (zero)  Apply Text Body paragraph style  

Ctrl+F2  Insert Fields  Ctrl+1  Apply Heading 1 paragraph style  

F3  Complete AutoText  Ctrl+2  Apply Heading 2 paragraph style  

Ctrl+F3  Edit AutoText  Ctrl+3  Apply Heading 3 paragraph style  

Shift+F4  Select next frame  Ctrl+4  Apply Heading 4 paragraph style  

Ctrl+Shift+F4  Open Data Source View  Ctrl+5  Apply Heading 5 paragraph style  

F5  Navigator on/off  Ctrl + Plus Key(+)  Calculates the selected text and copies   

Ctrl+Shift+F5  go to page number  Shift+Enter  Line break without paragraph change  

F7  Spellcheck  Ctrl+Enter  Manual page break  

Ctrl+F7  Thesaurus  Ctrl+Shift+Enter  Column break in multi columnar texts  

F8  Extension mode  Alt+Enter  Insert a new paragraph without numbering   

Ctrl+F8  Field shadings on / off  Arrow Left  Move cursor to left  

Shift+F8  Additional selection mode  Shift+Arrow Left  Move cursor with selection to the left  

F9  Update fields  Ctrl+Shift+Arrow Left  Selecting to the left word by word  

Ctrl+F9  Show fields  Arrow Right  Move cursor to right  

Shift+F9  Calculate Table  Arrow Up  Move cursor up one line  

Ctrl+F10  Nonprinting Characters on/off  Shift+Arrow Right  Move cursor with selection to the right  

F11  Styles window on/off  Shift+Arrow Up  Selecting lines in an upwards direction  

Shift+F11  Create Style  Arrow Down  Move cursor down one line  

Ctrl+F11  Sets focus to Apply Style box  Shift+Arrow Down  Selecting lines in a downward direction  

Ctrl+Shift+F11  Update Style  Home  Go to beginning of line  

F12  Numbering on  Home+Shift  Go and select to the beginning of a line  

Ctrl+F12  Insert or edit Table  End  Go to end of line  

Shift+F12  Bullets on  End+Shift  Go and select to end of line  

Ctrl+Shift+F12  Numbering / Bullets off  Ctrl+Home  Go to start of document  

Ctrl+A  Select All  Ctrl+Home+Shift  Go and select text to start of document  

Ctrl+J  Justify  Ctrl+End  Go to end of document  

Ctrl+D  Double Underline  Ctrl+End+Shift  Go and select text to end of document  

Ctrl+E  Centered  Ctrl+PageUp  Switch cursor between text and header  
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Ctrl+H  Find and Replace  Ctrl+PageDown  Switch cursor between text and footer  

Ctrl+Shift+P  Superscript  Insert  Insert mode on/off  

Ctrl+L  Align Left  PageUp  Screen page up  

Ctrl+R  Align Right  Shift+PageUp  Move up screen page with selection  

Ctrl+Shift+B  Subscript  PageDown  Move down screen page  

Ctrl+Y  Redo last action  Shift+PageDown  Move down screen page with selection  

Shortcut Keys for Paragraphs and Heading Levels  

Shortcut keys  Effect  

Ctrl+Alt+Up Arrow  Move the active paragraph or selected paragraphs up one paragraph.  

Ctrl+Alt+Down Arrow  Move the active paragraph or selected paragraphs down one paragraph.  

Tab  The heading in format "Heading X" (X = 1-9) is moved down one level in the outline.  

Shift+Tab  The heading in format "Heading X" (X = 2-10) is moved up one level in the outline.  

Ctrl+Tab  At the start of a heading: Inserts a tab stop. Depending on the Window Manager in use, 

Alt+Tab may be used instead.  

  

Shortcut Keys for Tables in LibreOffice Writer  

Shortcut Keys  Effect  

Ctrl+A  If the active cell is empty: selects the whole table. Otherwise: selects the contents of the active 

cell. Pressing again selects the entire table.  

Ctrl+Home  
If the active cell is empty: goes to the beginning of the table. Otherwise: first press goes to 

beginning of the active cell, second press goes to beginning of the current table, third press 

goes to beginning of document.  

Ctrl+End  
If the active cell is empty: goes to the end of the table. Otherwise: first press goes to the end of 

the active cell, second press goes to the end of the current table, and third press goes to the 

end of the document.  

Ctrl+Tab  
Inserts a tab stop (only in tables). Depending on the Window Manager in use, Alt+Tab may be 

used instead.  

Alt+Arrow Keys  Increases/decreases the size of the column/row on the right/bottom cell edge  

Alt+Shift+Arrow Keys  Increase/decrease the size of the column/row on the left/top cell edge  

Alt+Ctrl+Arrow Keys  Like Alt, but only the active cell is modified  

Ctrl+Alt+Shift+Arrow  Like Alt, but only the active cell is modified  

Ctrl+Shift+T  
Removes cell protection from all selected tables. If no table is selected, then cell protection is 

removed from all of the tables in the document.  
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Shortcut Keys for Moving and Resizing Frames, Graphics and Objects  

Shortcut Keys  Effect  

Esc  Cursor is inside a text frame and no text is selected: Escape selects the text frame.  

Text frame is selected: Escape clears the cursor from the text frame.  

Alt+Arrow Keys  Move object.  

Alt+Ctrl+Arrow Keys  Resizes by moving lower right corner.  

Alt+Ctrl+Shift+Arrow 

Keys  Resizes by moving top left corner.  

Ctrl+Tab  Selects the anchor of an object (in Edit Points mode).  

   

  

Shortcut Keys for LibreOffice- Calc 

  

  

Shortcut Keys  Effect   

Ctrl+Home  Moves the cursor to the first cell in the sheet (A1).  

Ctrl+End  Moves the cursor to the last cell on the sheet that contains data.  

Home  Moves the cursor to the first cell of the current row.  

End  Moves the cursor to the last cell of the current row.  

Shift+Home  Selects cells from the current cell to the first cell of the current row.  

Shift+End  Selects cells from the current cell to the last cell of the current row.  

Shift+Page Up  
Selects cells from the current cell up to one page in the current column or extends the existing 

selection one page up.  

Shift+Page Down  
Selects cells from the current cell down to one page in the current column or extends the existing 

selection one page down.  

Ctrl+Left Arrow  
Moves the cursor to the left edge of the current data range. If the column to the left of the cell 

that contains the cursor is empty, the cursor moves to the next column to the left that contains 

data.  

Ctrl+Right Arrow  
Moves the cursor to the right edge of the current data range. If the column to the right of the cell 

that contains the cursor is empty, the cursor moves to the next column to the right that contains 

data.  

Ctrl+Up Arrow  
Moves the cursor to the top edge of the current data range. If the row above the cell that 

contains the cursor is empty, the cursor moves up to the next row that contains data.  
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Ctrl+Down Arrow  
Moves the cursor to the bottom edge of the current data range. If the row below the cell that 

contains the cursor is empty, the cursor moves down to the next row that contains data.  

Ctrl+Shift+Arrow  
Selects all cells containing data from the current cell to the end of the continuous range of data 

cells, in the direction of the arrow pressed.   

Ctrl+Page Up  Moves one sheet to the left.  

In the print preview: Moves to the previous print page.  

Ctrl+Page Down  Moves one sheet to the right.  

In the print preview: Moves to the next print page.  

Alt+Page Up  Moves one screen to the left.  

Alt+Page Down  Moves one screen page to the right.  

Ctrl+ /  where (/) is the division sign on the numeric key pad  

Selects the matrix formula range that contains the cursor.  

Ctrl+Plus key  Insert cells (as in menu Insert - Cells)  

Ctrl+Minus key  Delete cells (as in menu Edit - Delete Cells)  

   

  

Shortcut Keys  Effect   

Ctrl+F1  Displays the comment that is attached to the current cell  

F2  Switches to Edit mode of the current cell. Press again to exit Edit mode.  

Ctrl+F2  Opens the Function Wizard.  

Shift+Ctrl+F2  Moves the cursor to the Input line where you can enter a formula for the current cell.  

Ctrl+F3  Opens the Define Names dialog.  

Shift+Ctrl+F4  Shows or Hides the Database explorer.  

F4  Rearranges the relative or absolute references (for example, A1, $A$1, $A1, A$1) in the input field.  

F5  Shows or hides the Navigator.  

Shift+F5  Traces dependents.  

Shift+F7  Traces precedents.  

Shift+Ctrl+F5  Moves the cursor from the Input line to the Sheet area box.  

F7  Checks spelling in the current sheet.  

Ctrl+F7  Opens the Thesaurus if the current cell contains text.  

F8  Turns additional selection mode on or off.   

Ctrl+F8  Highlights cells containing values.  
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F9  Recalculates changed formulas in the current sheet.  

Ctrl+Shift+F9  Recalculates all formulas in all sheets.  

Ctrl+F9  Updates the selected chart.  

F11  Opens Styles window where you can apply a formatting style to the contents of cell/current sheet.  

Shift+F11  Creates a document template.  

Shift+Ctrl+F11  Updates the templates.  

F12  Groups the selected data range.  

Ctrl+F12  Ungroups the selected data range.  

Alt+Down Arrow  Increases the height of current row (only in OpenOffice.org legacy compatibility mode).  

Alt+Up Arrow  Decreases the height of current row (only in OpenOffice.org legacy compatibility mode).  

Alt+Right Arrow  Increases the width of the current column.  

Alt+Left Arrow  Decreases the width of the current column.  

  

Formatting Cells Using Shortcut Keys  

Shortcut Keys  Effect   

Ctrl+1 (not on the number pad)  Open Format Cells dialog  
Ctrl+Shift+1 (not on the number 

pad)  Two decimal places, thousands separator  
Ctrl+Shift+2 (not on the number 

pad)  Standard exponential format  
Ctrl+Shift+3 (not on the number 

pad)  Standard date format  
Ctrl+Shift+4 (not on the number 

pad)  Standard currency format  
Ctrl+Shift+5 (not on the number 

pad)  
Standard percentage format (two decimal 

places)  
Ctrl+Shift+6 (not on the number 

pad)  Standard format  

  
  

Shortcut Keys for LibreOffice- Impress 

  

   

Shortcut Keys  Effect   

Esc   End presentation.  

Spacebar or Right arrow or Down arrow or Page  

Down or Enter or Return or N   

Play next effect (if any, else go to next slide).  

Alt+Page Down  Go to next slide without playing effects.  
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[number] + Enter  Type a number of a slide and press Enter to go to the slide.  

Left arrow or Up arrow or Page Up or Backspace or  

P   

Play previous effect again.  

Alt+Page Up  Go to the previous slide without playing effects.  

Home   Jump to first slide in the slide show.  

End   Jump to the last slide in the slide show.  

Ctrl+ Page Up   Go to the previous slide.  

Ctrl+ Page Down   Go to the next slide.  

B or .  Show black screen until next key or mouse wheel event.  

W or ,  Show white screen until next key or mouse wheel event.  

  

Shortcut Keys in the Normal View  

Shortcut Keys  Effect   

Plus(+) Key  Zoom in.  

Minus(-) Key  Zoom out.  

Times(×) Key (number pad)  Fit page in window.  

Divide(÷) Key (number pad)  Zoom in on current selection.  

Shift+Ctrl+G  Group selected objects.  

Shift+Ctrl+Alt+A  Ungroup selected group.  

Ctrl+ click  
Enter a group, so that you can edit the individual objects of the group. Click outside the 

group to return to the normal view.  

Shift+Ctrl+ K  Combine selected objects.  

Shift+Ctrl+ K  
Split selected object. This combination only works on an object that was created by 

combining two or more objects.  

Ctrl+ Plus key  Bring to Front.  

Shift+Ctrl+ Plus key  Bring Forward.  

Ctrl+ Minus key  Send Backward.  

Shift+Ctrl+ Minus key  Send to Back.  

  
Shortcut Keys when Editing Text  

Shortcut Keys  Effect   

Ctrl+Hyphen(-)  Soft hyphens; hyphenation set by you.  



UPCISS 
 

79 
 

Ctrl+Shift+minus sign (-)  Non-breaking hyphen (is not used for hyphenation)  

Ctrl+Shift+Space  
Non-breaking spaces. Non-breaking spaces are not used for hyphenation and are not 

expanded if the text is justified.  

Shift+Enter  Line break without paragraph change  

Arrow Left  Move cursor to left  

Shift+Arrow Left  Move cursor with selection to the left  

Ctrl+Arrow Left  Go to beginning of word  

Ctrl+Shift+Arrow Left  Selecting to the left word by word  

Arrow Right  Move cursor to right  

Shift+Arrow Right  Move cursor with selection to the right  

Ctrl+Arrow Right  Go to start of next word  

Ctrl+Shift+Arrow Right  Selecting to the right word by word  

Arrow Up  Move cursor up one line  

Shift+Arrow Up  Selecting lines in an upwards direction  

Ctrl+Arrow Up  Move cursor to beginning of the previous paragraph  

Ctrl+Shift+Arrow Up  Select to beginning of paragraph.   

Arrow Down  Move cursor down one line  

Shift+Arrow Down  Selecting lines in a downward direction  

Ctrl+Arrow Down  Move cursor to end of paragraph. Next keystroke move cursor to end of next paragraph  

Ctrl+Shift+Arrow Down  Select to end of paragraph. Next keystroke extends selection to end of next paragraph  

Home  Go to beginning of line  

Shift+Home  Go and select to the beginning of a line  

End  Go to end of line  

Shift+End  Go and select to end of line  

Ctrl+Home  Go to start of text block in slide  

Ctrl+Shift+Home  Go and select text to start of text block in slide  

Ctrl+End  Go to end of text block in slide  

Ctrl+Shift+End  Go and select text to end of document  

Ctrl+Del  Delete text to end of word  

Ctrl+Backspace  Delete text to beginning of word  

Ctrl+Shift+Del  Delete text to end of sentence  

Ctrl+Shift+Backspace  Delete text to beginning of sentence  
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Shortcut Keys  Effect   

Arrow key  Moves the selected object or the page view in the direction of the arrow.  

Ctrl+ Arrow Key  Move around in the page view.  

Shift + drag  Constrains the movement of the selected object horizontally or vertically.  

Ctrl+ drag   Hold down Ctrl and drag an object to create a copy of the object.  

Alt Key  Hold down Alt to draw or resize objects by dragging from the center of the object outward.  

Alt key+click  Select the object behind the currently selected object.  

Alt+Shift+click  Select the object in front of the currently selected object.  

Shift+click  
Select adjacent items or a text passage. Click at the start of a selection, move to the end of the 

selection, and then hold down Shift while you click.  

Shift+drag   Hold down Shift while dragging to resize an object to maintain the proportions of the object.  

Tab key  Select objects in the order in which they were created.  

Shift+Tab  Select objects in the reverse order in which they were created.  

Escape  Exit current mode.  

Enter  Activate a placeholder object in a new presentation (only if the frame is selected).  

Ctrl+Enter  Moves to the next text object on the slide.  

PageUp  Switch to the previous slide. No function on the first slide.  

PageDown  Switch to the next slide. No function on the last slide.  

Home/End  Set the focus to the first/last slide.  

Enter  Change to Normal Mode with the active slide.  

  

Function Keys for LibreOffice Impress  

Shortcut 

Keys  Effect       

F2  Edit text.  F7  Spellcheck  

F3  Enter Group.  Ctrl+F7  Thesaurus  

Ctrl+F3  Exit Group.  F8  Edit Points.  

Shift+F3  Duplicate  Ctrl+Shift+F8  Fit text to frame.  

F4  Position and Size  F11  Styles  

F5  View Slide Show.  Ctrl+Shift+F5  Navigator  

  

  


